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Welcome
What is the F20 used for?

The Filmetrics F20 is used to measure the thickness and optical constants (n and k) of dielectric and

semiconductor thin films. Measured films must be optically smooth and within the thickness range

set by the system configuration requirements specified in Performance Specifications. Commonly

measured films include semiconductor process films such as oxides, nitrides, resists, and poly-

silicon, optical coatings such as hardness and anti-reflection coatings, flat panel display films such

as polyimides, resist, and cell gaps, and the various coatings used in CD and DVD manufacture.



Safety, Maintenance and Care

This symbol indicates information or instructions that must be read and carefully followed to pre-

vent hazards, injury to the operator, or damage to the instrument.

This symbol indicates a potential shock hazard. Areas marked with this symbol should be serviced

by a trained service technician.

This symbol indicates that the product conforms to the WEEE (Waste in Electrical and Electronic

Equipment) Directive 2002/96/EC.

This symbol indicates that the product meets the applicable EU safety, health and environmental

protection directive requirements.

This label indicates the Model Number and Serial Number of the instrument. This information may

be necessary when contacting Filmetrics for assistance.



Disclaimer:Use of this instrument in a manner inconsistent with the information and directions

included in this manual may impair the protections designed into the product resulting in danger to

the operator or damage to the instrument

Installation Location:When deciding on a location for the instrument, ensure that the instrument

in installed in a well-ventilated location. Enclosing the unit, or blocking the vent holes, may impair

the performance of the instrument of damage the internal components.

Cleaning:The need for periodic cleaning of the system is based on the cleanliness of the envi-

ronment in which the system is installed. Only the external surfaces are to be cleaned. Cleaning

and maintenance of all internal components is to be performed by a trained service technician. Do

not use aerosol, or spray, cleaners as they may contaminate the sensitive optical surfaces on the

instrument.

Before performing any service on the instrument ensure that the main power is disconnected.

Cleanroom, or low lint, wipes should be used to wipe down the system. A mixture of Isopropyl

Alcohol (IPA) and De-ionized Water (DI H2O) at 70% DI H2O: 30% IPA is to be used for clean-

ing. Undiluted IPA may be used, if the 70:30 DI and IPA mixture is not available, but extra care

must be taken. Avoid using stronger solvents, such as acetone, as these may compromise the sur-

face finish.

Avoid excessive pressure on any surface when cleaning. Excessive force may bend a component,

which would damage the system, or cause the system to be out of alignment.

Start with the top of the system and work down. Use slow motions, in a straight line, from the back

to the front of the surface being cleaned. Change the cleaning wipe periodically to avoid re-depos-

iting material back onto the surface being cleaned. Allow all cleaned surfaces to dry completely

before restoring power to the system.



CE Mandated Warnings

Please read the following instructions carefully to prevent potential shock or fire hazards. This

manual should be retained for future use

Bitte lesen Sie die nachstehende Anleitung sorgfältig durch um Stromschlag und Feuergefahr zu

vermeiden. Diese Betriebsanleitung sollte für späteren Gebrauch sorgfältig aufbewahrt werden.

Preghiamo di leggere accuratamente, le sequenti Instruzioni, per evitare Prossiomi Incendi e

Correnti.

Shock Hazard - Do Not Enter

Achtung Hochspannung - Nicht Berühren

Attenzione Corrent-Forte - Prego non toccare

The front panel’s switch is not the power disconnect device. The power cord should be removed

after use.

Der Kippschalter an der Vorderseite unterbricht nicht die Stromzuführung. Das Stromkabel sollte

nach Gebrauch aus dem Gerät herausgezogen werden.

L’interutore nella parete frontale non blocca le Corrente. La Corrente viene.

Never expose the unit to water or liquids. Avoid direct sun.

Bringe das Gerät nicht mit Wasser oder einer anderen Flüssigkeiten in Berührung. Vermeide

direkte Sonneneinstrahlung.



Evitare contatto con acqua oppure liquidi Infiammabili al Macchineggio. Auche entrate di Sole.

Do not insert any objects into the unit.

Keinen Gegenstand in das Gerät einbringen. Do non inseriamo any obietta into gli unità.

Non mettere ogetti dentro la Macchina.

Do not use near open flame or heat.

Das Gerät nicht in der Nähe einer offenen Flamme oder Hitze benutzen.

Non mettere la Macchina vicino a fuochi oppure Riscaldamenti.

The unit should never be enclosed or blocked.

Das Gerät darf nicht eingeschlossen oder blockiert werden.

La Macchina non chinderla per nessun motivo.

Connect unit only to a properly measured supply. Use only three wire cord which is provided

with the unit.

Schließen Sie das Gerät nur an eine ordnungsgemäss vermessene Stromsversorgung an.

Verwende nur ein dreiadriges Kabel, wie es auch mit dem Gerät ausgeliefert wird.

Montare solo con misura normata. Adoperando solo 3 cavi elettrici cosi come e fornita la

Macchina.



Software Overview
The way that light reflects off of a thin film is determined by the characteristics of the film, such as

its thickness, optical constants, and roughness. The F20 is able to determine thin-film char-

acteristics by first carefully measuring the amount of light reflected from the thin film over a range

of wavelengths (i.e., by measuring the reflectance spectrum), and then analyzing this data by com-

paring it to a series of calculated reflectance spectra. Most of the features of the FILMeasure soft-

ware that runs the F20 can be divided into reflectance acquisition and reflectance analysis

functions. The following pages outline the main features of the FILMeasure software.

The basic steps for any F20 measurement are selecting and editing the film structure, taking a base-

line measurement, and then making and evaluating the measurement. The details of each of these

steps are explained below, followed by descriptions of other FILMeasure functions.

Measure Tab

1. Standard Windows File menu for saving and retrieving data, printing, etc.



2. The Editmenu is used for viewing and editing the material library.

3. Used to Setup various parameters and the graphic display.

4. For starting and stopping continuous reflectance acquisition and data measurement.

5. Used to access the Help, Diagnostic and Support functions of the software.

6. Shows that theMeasure tab is currently selected.

7. Used to select the History tab.

8. This is the thickness result from the measured spectrum.

9. This button causes spectra to be acquired and analyzed.

10. The baseline measurement sequence, which is required before measurements are made, is ini-

tiated by pressing the Baseline button.

11. This button analyzes the selected spectra.

12. This is used to select Recipe settings that correspond to different samples to be measured.

13. This is where the Recipe (the film stack definition and data acquisition and analysis settings) is

set. Hundreds of recipes can be saved and later recalled.

14. This box provides more details about the calculated thickness, as well as any additional param-

eters that were solved for, including Roughness, n and k, and Non-Uniformity as well as the

Goodness of Fit (GOF).

15. Graphical display for spectra. A click of the right mouse button while the cursor is within the

graphical display activates a blue line (one click for measured curve) for easy reading of cursor

values in the main FILMeasure window. Keyboard up/down and right/left arrows move the line to

a desired location.

The graph limits can be changed by double-clicking on the graph display. The Horizontal Axis

Minimum andMaximum fields are used to control the wavelength range displayed on the screen.

Use the Vertical Axis Minimum andMaximum fields to control the vertical-axis display. Check

the Autoscale Maximum checkbox to activate y-axis autoscaling. The lower value is always 0 for

autoscaling; the maximum y-axis upper limit is 5000. Changing the Vertical Axis will change the

reflectance axis, the Vertical Axis 2 will change the transmittance axis. The axes can be set to dis-

play in percent or as a decimal value (100% = 1).



Graph Options can be accessed and edited by double-clicking on the main graph window.

16. This allows the user to enter information about the Operator and Sample for tracking purposes.



History Tab

1. Standard Windows File menu for saving and retrieving data, printing, etc.

2. The Editmenu is used for viewing and editing the material library.

3. Used to Setup various parameters and the graphic display.

4. For starting and stopping continuous reflectance acquisition and data measurement.

5. Used to access the Help, Diagnostic and Support functions of the software.

6. Used to select theMeasure tab.

7. Shows that the History tab is currently selected.

8. Selecting theMeasurement Trend tab will allow the user to see a plot of the measurement

results versus measurement number.



When the Measurement Trend tab is selected in the History window, the right side of the screens graphs the

results.

9. Displays the measurement results for the currently selected measurement number.

10. Displays the spectra for the currently selected measurement number.

11. Saves the history file.

12. Deletes the currently selected spectra.

13. Clears the history file.

14. Copies the selected data to the clipboard.

15. Sends the selected spectra and the associated recipe back to the measure tab.

16. Displays the statistics of all past measurements.

17. Shows all measurements numbers. Selecting a measurement number will cause the associated

spectrum and measurement results to be displayed on the right side.



Edit Recipe Window
The Edit Recipe Window is used to define the film stack and to set analysis and acquisition param-

eters.

A recipe defines the film to be measured and its approximate thickness, any other films present,

and the quantities to be measured:

1. Open a saved Recipe file.

2. Clear all settings and start a New Recipe.

3. Save the current recipe settings.

4. Save the current recipe settings as a new file.

5. Delete the current recipe.



6. Select from different recipes saved under the Recipes folder.

7. Author, as defined by user login name and recipe modification date are indicated here.

8. Additional solving options for Composition, Thickness, and Non-Uniformity can be hidden or

revealed by pressing the + or - buttons.

9. Constraints on the possible measured values are selected here.

10. OK closes the Edit Recipe box, retaining any changes made.

11. The Cancel button closes the Edit Recipe box without retaining changes.

12. Apply will not be permanently saved unless Save or Save As New… is selected.

13. These tabs allow the users to navigate to the various other recipe settings.

14. The thickness units are chosen here. The choices include angstroms (Å, 10e-10 m), nanometers

(nm, 10e-9 m), kilo-angstroms (kÅ, 10e-7 m), microns (µm, 10e-6 m), mils and microinches.

15. Adds a new layer.

16. Deletes the selected layer

17. This pulldown menu allows the user to select the desired material file. Also, left-clicking on the

text will open the Search Materials dialog box.

Editing Film Structures
The description of the nominal film structure, as well as the measurement parameters, is specified

in the Edit Recipe dialog box. Dozens of different film structures and their measurement spec-

ifications may be saved using the Edit Recipe dialog box.

The Edit Recipe dialog box is accessed with the Edit Recipe button on theMeasure Tab. The

Edit Recipe dialog box lists an initial guess at the specifications of the film structure to be meas-

ured. These specifications include the name of the film structure (which identifies it in the Recipe:

list), the number of films in the structure, the specifications of individual films, and the quantities to

be measured.

Adding, Changing, or Deleting a Structure
When the dialog box is opened, it shows the stored specifications of the structure selected from the

Recipe: list, along with any changes made since the program was started. Changes to the structure

selected can be permanently stored by making the desired changes and then clicking on Save



Changes. New structures may be added to the Recipe: list by opening the Edit Recipe dialog

box, setting the desired specifications, and then clicking on Save As. Similarly, a structure may be

deleted (removed from the Recipe: list) by clicking on the Delete Recipe button.

Edit Recipe>Film Stack window.



Film Stack

The Film Stack tab is used to define the film structure, as well as the starting guesses and con-

straints for thickness, n and k. This is also where you determine your analysis method, Grid, FFT ,

or None, as well as any Non-Uniformity that may be present in the sample. Additional options for

Composition, Thickness and Non-Uniformity can be selected or hidden by using the + and - but-

tons.

Setting Up a Film Stack

When measuring a layer, the specifications (d, n, k, and roughness) of the known films (including

the incident medium and substrate) must be entered into the proper fields in the Edit Recipe dialog

box, as well as initial guesses for the values to be measured. The refractive index (n) and extinction

coefficient (k) values for common materials can be selected automatically with the pull-down

menus on the left-hand side of the Edit Recipe dialog box, or by clicking on the box and using the

Search function.

If a material is being measured which is not present in the material library there are three possible

approaches:



a) choose a material in the library that is similar.

b) if the material is transparent (an insulator), select “Enter Refractive Index Value” from

the material list and enter a value for the refractive index (n will automatically be varied by

FILMeasure to account for dispersion effects, with the entered value being n at 632 nm).

c) in the Edit>Material Library… dialog box, enter the refractive index values for n and k as

a function of wavelength and save the files so that they may be selected as in a). See Creating

and Editing n and k Files for more information.

Choosing the Films to be Measured

To measure a film's thickness, check the Vary box on the right-hand side of the Film Stack field

in the Edit Recipe dialog box. When no boxes are checked, the theoretical spectrum for the spec-

ified layer stack and thicknesses will be displayed.

As with most measurements, the uncertainty of the measured data increases as the number of simul-

taneously measured values increases. Thus it is best to provide as much information about the film

structure as possible.

Constraints

By setting constraints, the user can limit the possible values of the measured film properties. The

constraints are set in conjunction with the values entered in the Range dialog box for thickness.

For example, if the initial guess of the measured thickness of a film is 100 nm and the thickness

constraint is set at 50%, FILMeasure will only consider possible thicknesses in the range 50 nm to

150 nm. The constraints for n and k are set using the n and k dialog boxes under Composition.

These boxes are only visible when the Composition option is expanded. You can select between

constraining by a percent of the thickness guess, or by a selected thickness by clicking on the % or

measurement unit above the constraints dialog box. Constraining the measurement range can speed

up the measurements and can also help exclude non-physical solutions.

nk Model

When measuring n and k for a film, the general dependence of these values upon wavelength must

be specified. This dependence is determined by the type of material to be measured. For example,

insulators, semiconductors, and metals all have a unique type of n and k wavelength dependence.

Dozens of models for these different dependencies have been proposed and used over the years.

FILMeasure uses a few of the most versatile and accepted of these models. For insulators, the Cau-

chy model is used, for semiconductors, either the Amorphous or Bridge-Lorentzian model, and for

metals, the Drude model. There are also a number of special-purpose models for specific appli-

cations. These models, and starting coefficients values, are selected automatically when a material

is chosen from theMaterial lists in the Edit Recipe dialog box. Other models may also be spec-

ified by selecting them from the nkModel pulldown menu under the Composition tab which is

accessed by right clicking on the Vary checkbox.



Fourier search for thickness

The FFT option in the thickness dropdown is an alternative option to let FILMeasure choose an ini-

tial thickness for analysis. The Fourier Transform method analyzes the oscillations present in the

spectrum and determines the film thicknesses based on the periodicity of those oscillations. It is

somewhat less robust than the Grid method, but is better at finding the correct thickness in cases

where the shape of the initial theoretical spectrum is different than the measured data (i.e., the reflec-

tance spectrum is non-ideal in some way) or in cases where there is more than one film thickness is

being measured.

Grid search for thickness

There are a number of methods that FILMeasure can use to determine thickness. None is perfect –

each is a different trade-off between speed, accuracy, and robustness (i.e., the ability to find the

best solution among many that are nearly as good). Because thickness can vary over many orders

of magnitude and many near-solutions exist, it is often best to use a very robust method to get close

to the best solution, and then let a more accurate method take over. One very robust method is the

Grid method, which can be activated by selecting the Grid option in the thickness dropdown. The

Grid method searches the entire allowed thickness range (as defined by the initial guess and the

constraints) to find the best initial thickness. However, on some very complex multilayer spectra, it

is possible for the Grid method to become confused and give the wrong answer. In such cases it is

best to use the Fourier Transformmethod to determine initial thicknesses, or to provide them

manually.



Non-Uniformity

Selecting this option enables modeling of thickness non-uniformity within the measurement spot.

An initial guess for Non-Uniformity must first be made, and then solving can be enabled or dis-

abled by toggling the check box.



Search

The Search Materials dialog box is accessible by left clicking on a material name in the Edit

 Recipe > Film Stack tab. This feature allows the user to search for materials by using either the

materials name, or a keyword for a certain class of materials. The search function will also show a

brief Description of the material selected, as well as any Synonyms orKeywords related to the

material file. The Similar Materials box will list any materials that may have similar optical prop-

erties.



Analysis Options

Correct setting of the following options will help ensure accurate measurements. Many of the

options are set automatically when film information is supplied in the Edit Recipe dialog box, and

all of them can be saved so that subsequent measurements can be made as quickly and easily as

possible. If Robust (Adaptive; Thickness Only) or FFT (Thickness Only) is checked, only the

Data Selection settings will be accesible.

Data Selection

Wavelength Range

This sets the wavelength range of data that is to be analyzed. It may be either the range displayed

on the current graph or a fixed range. Wavelength range may also be changed by dragging the

ends of the gray bar near the bottom of the graph area.

Smoothing

This function performs wavelength-dependent boxcar averaging on the measured spectra. This can

improve signal-to-noise levels and can filter out oscillations that correspond to optical thicknesses

(defined as index multiplied by thickness) equal or greater than the specified value. This value

should be lowered to increase smoothing, and raised to decrease smoothing. To eliminate smooth-

ing, a very high value (for example, 1000 um) should be entered.



Source Data

If both are present, this tells the software whether to analyze the reflection data, transmission data,

or both. Only possible on spectra from the F10-VC, F10-RT, and F10-PARTS.

Data Selection

Wavelength Range

This sets the wavelength range of data that is to be analyzed. It may be either the range displayed

on the current graph or a fixed range. Wavelength range may also be changed by dragging the

ends of the gray bar near the bottom of the graph area.

Smoothing

This function performs wavelength-dependent boxcar averaging on the measured spectra. This can

improve signal-to-noise levels and can filter out oscillations that correspond to optical thicknesses

(defined as index multiplied by thickness) equal or greater than the specified value. This value

should be lowered to increase smoothing, and raised to decrease smoothing. To eliminate smooth-

ing, a very high value (for example, 1000 um) should be entered.

Source Data

If both are present, this tells the software whether to analyze the reflection data, transmission data,

or both. Only possible on spectra from the F10-VC, F10-RT, and F10-PARTS.



Analysis Options: Advanced

Advanced Analysis Options for Spectrum Matching.

Convergence Criteria

This sets the minimumGOF between the measured and calculated spectra that is attained before

the measurement routines consider the solution final. In most cases a value of 0.999 is sufficient.

For cases where the desired GOF is not attainable, the value in theMaximum Iterations field lim-

its the number of iterations performed by the analysis routine.

Solver Cycles

This option will enable multiple solver cycles, with the number of cycles being defined by the

number included in the box. When using this option, the software will run through the model for a

solution once, and then try again starting from the solution previously found. A greater number of

cycles will lead to a slower analysis.

Display Details

This feature controls the wavelength at which n and k are displayed in theMeasurement Details

portion of the main screen. These values are only displayed if solving for n or k is enabled in the

Film Stack window.



Advanced Analysis Options for FFT Analysis.

FFT Analysis Window

When the FFT solver is enabled, the advanced options gives you options to help Optimize the per-

formance of the analysis. When optimize position is enabled, The solver with check for the best

possible GOF value in different areas across the spectrum as defined by the window size. For

example, if a window size of 200 nm is selected, the solver will look at six different 200nm sec-

tions of the spectrum, and then select the range the provides the best GOF.

If Optimize Size is enabled, the solver will instead begin with a minimum window size as defined

by the user. It will then start at the center of the analysis range, and then extend equally in both

directions six times to find the best GOF. When Optimize Position and Size is selected, the soft-

ware does both functions, resulting in measuring thirty-one different combinations of location and

analysis range.

Exact Spectrum Matching

Unmodelled Back-Side Reflections

When measuring films in transparent substrates, reflectance off of the backside of the substrate may

occur. Selecting compensate for Unmodelled Back-Side Reflections allows the software to shift

the intensity of the reflectance curve to account for the additional light. This feature should not be

used when measuring very thin films (< 100 nm).

Tilted Sample/Lost Light

Samples with nonplanar surfaces scatter some of the light away from the collection optics. This

option automatically compensates for the light lost due to nonplanarity.



Lock Identical Layers

Samples comprised of repeating layers can be more accurately measured by activating this option.

By activating these options, all properties of any layers that initially have the same material or thick-

ness are locked together.

Display Details

When solving for n and k, the values displayed in the Results Summary box of theMeasure Tab

will be the values determined for the wavelength entered here.

Enable Robust (Adaptive; Thickness Only)

If thickness of a single-layer film is the only property to be measured and the film is greater than

150 nm, then the Robust (Adaptive;Thickness Only)mode is often recommended. This mode

can oftentimes result in successful measurements when the reflectance data is affected by non-ideal

film properties, such as thickness and composition non-uniformities and birefringence. The range

of thicknesses tested is constrained by the limits set in the Constraints field in the Film Stack tab.

Selecting this feature will limit the Analysis Options tab settings available.

Enable FFT (Thickness Only)

If thickness is the only property to be measured and the film is greater than about 250 nm, then the

FFT (Thickness Only)mode can be used. This mode is usually the most effective technique when

the sample has multiple film thicknesses to be measured. Selecting this feature will limit the Anal-

ysis Options tab settings available.



Acquisition Settings

This menu lets the user control sampling settings, active spectrometers (on EXR and UVX sys-

tems), and required baseline reference.

Measurement Timing

Use Recommended Sampling Time

Selecting this option uses the sampling time that has been automatically calculated by the software

during the baseline procedure. This value is the total sampling time and not necessarily the inte-

gration time. To see the integration time and number of integration cycles go to the Help > Diag-

nostics menu.

Use Maximum Sampling Time

Users can set a maximum sampling time by selecting this option. This option allows the user to

tradeoff between measurement speed and improved signal-to-noise.



Use Manually Set Parameters

Users can set the integration time per acquisition cycle and set a number of integration cycles over

which to average. When using this option, the total sampling time is equal to the integration time

multiplied by the number of integration cycles.

To set the integration time manually, set the sample on the stage and select Setup>Raw Signal…

If the proper integration time is unknown, an initial value of 40ms is a good starting guess. The ver-

tical scale of the spectrum extends from zero to 4095. Thus, a good working level is when the peak

height of the sample being measured, or the reference sample, whichever is greater, is 3000-3500

counts. (Note: if the reference measurement saturates – Detector Saturation error – then spurious

final measurements will result.) If the maximum signal is too low, increase the integration time.

Too large an integration time will result in excessive dark current, so it is sometimes necessary to

accept a smaller signal level to limit the dark current.

* * Note * * If the integration time is changed, it will be necessary to perform the baseline pro-

cedure, or re-acquire the background and reference scans.

Spectrometer Type

EXR and UVX systems have two spectrometers (VIS/UV and NIR). Here the user can choose to

use only one or both spectrometers.



Alarms

GOF Error

Constraining the GOF Error will exclude measurements where the calculated GOF does not

reach the specified limit. A warning or “Invalid” result will appear if the GOF constraint is not

met. Specify 0 to have all solutions reported.

Activate Alarms

When Activate Alarms is selected, an alarm will trigger if the measured thickness of the sample is

outside the specified Thickness Limits.

Thickness Limits

Setting the minimum and maximum allowable thickness limits will trigger an alarm if the measured

thickness is outside the limits when Activate Alarms is selected.



Understand and Evaluating Measurement Results
This section covers information on the Display of Measured Spectra and a more in depth look at

the Goodness Of Fit value.

Display of Measured Data
Once film stack and measurement information have been entered and baseline spectra taken, meas-

urements may be made by clicking on theMeasure button. After measurement, the measured and

calculated reflectance spectra are displayed on the graph. The thickness of the films are listed in the

results box. If any of the thickness values were measured, they are displayed in bold numbers.

Goodness of Fit
The accuracy of a calculation fit, and thus the reliability of the measurement, can be judged by the

match between the measured and calculated spectra, which is quantified by the GOF value. GOF

is a number between 0 and 1. 0 is a poor fit.

A perfect match between measured (blue) and theoretical (red) spectra will result in a GOF of 1.0.

To ensure accurate results the user may set a minimum acceptable GOF value by entering a

number between 0 and 1 into GOF Error on the Alarms Tab in Edit Recipe. A warning mes-

sage will be displayed after each measurement where the GOF falls below the user-specified GOF

Error. If the GOF is less than 1.0 there are several possible causes as follows:

a) Nonuniformity – Any variation of layer thickness, or presence of roughness, within the

measurement spot will result in a reduction in reflectance. In severe cases the interference

peaks may disappear entirely.

b) Incorrect Structure Definition – If the refractive index of one or more layers in the struc-

ture is different from what is described in the layer structure, then there may be some mis-

match between the blue curve and the red curve.

c)Graded Interfaces – The amplitude of the peaks in the spectrum depends on both the size

of the change in refractive index at each interface in the layer structure and the sharpness of

the interface. In many hardcoat samples you will find that there is some degree of layer inter-

mixing at the interface, leading to a weaker than expected reflectance at that interface. In

severe cases the peaks may disappear entirely.

Window Menu Items
This section describes the various functions available through the standard Windows File Menus.

File Menu

Edit Menu



Setup Menu

Acquire Menu

Help Menu

File Menu

Open Spectrum…(Measure Tab only)

This command is used to open stored reflectance spectra, which are then displayed and can be

analyzed for film properties.

Open Measured Template…(Measure Tab Only)

This command is used to open a saved Contact Probe Template Mode file.

Open History…

Previously saved history data containing measurements and statistics can be loaded with this com-

mand.

Import: Recipe…

To import recipes that were previously exported, or created with an older version of FILMeasure,

use this command.

Import: Material…

Custom materials, either created by the user or provided by Filmetrics, can be imported using this

command.

Import: License…

When the user purchases an upgrade for the system, Filmetrics will send a license file to the user.

The license must be imported into the software before upgrades are effective.



Save Measured Spectrum…(Measure Tab only)

This command is used to save spectra for export or later analysis. All data is saved along with the

corresponding wavelength data in comma-delimited format. Files can be saved in four different for-

mats:

*.fmspe: This file can only be opened in FILMeasure 6.0 or greater. Additional information from

data acquisition is stored in this file and is the preferred way to store your spectra.

*.spe: This file can be opened in all versions of FILMeasure.

*.csv: This is a comma-delimited file that can be opened directly in Excel.

*.txt: This is a tab-delimited file, and can be opened with a text editor.

Save Screen to File…(Measure Tab only)

This command takes a screenshot of the FILMeasure window.

Save n and k to files…(Measure Tab only)

This command is used to save the calculated n and k data to its own material file for use in the Edit

Recipe>Material list boxes. All data is saved along with the corresponding wavelength data in

comma-delimited format.

Export: Recipe…

Recipes can be exported for use on other computers running FILMeasure. The exported file will

also automatically include any material files required by the recipe. To duplicate an analysis, all

that is needed is the exported recipe and the spectrum being analyzed.

Export: Recipe for FILMeasure 4…

This command will convert a recipe for use with FILMeasure 4. This will not include material files

or recipe features only available in FILMeasure 6.

Export: SystemInfo File…

For certain upgrade purchases that can be done through software, the user will be required to send

the SystemInfo file to Filmetrics, which can be exported using this command.

Edit Menu

This Menu allows access to theMaterial Library.



Material Library

The material library is used to display information about existing materials as well as create new

ones. Material files shipped with FILMeasure have the file extension “.fibnk” and will only display

limited information. User created material files can be plotted on a graph or viewed in table form.

A new material may be entered into the material library manually if refractive index (n) and extinc-

tion coefficient (k) are known as a function of wavelength for the new material.

To create a new material file:

a. Select Edit>Material Library… menu item. The Edit Material dialog box will appear.

b. Click New… to create a new material.

c. Select the type of material you are ready to create (Metal, Semiconductor, Dielectric, Pho-

toresist, Other).

d. Optimize the functionality of the file by entering index values over the entire wavelength

spectrum of the system. The wavelength unit is nanometers. Enter index information every 20

to 50 nm, depending on the complexity of the data. In areas where n or k is quickly changing,

more densely spaced the points should be entered.



e. Alternatively, select on theModel>Custom option button and click theModel button. A

CustomModel Information dialog box will appear. Select the appropriate model. Enter in

the known coefficients and click OK. Cauchy coefficients are displayed in microns. If they are

entered in Å, FILMeasure will automatically detect this and convert them to microns.

f. Click the save button to save the material. You will be asked for a file name, and you may

select one of two file types:

*.fitnk: Compatible with FILMeasure 6 only.

*.nnn: Creates a *.nnn file and a *.kkk file to contain material data. This is compatible with

FILMeasure 6 and earlier.

Setup Menu

This menu contains the settings for manually obtaining the Reference and Background infor-

mation, Optics Configuration, Display options, and the Raw Signal dialog. This is also where

user access can be set through the Access Control option, as well as modifying some system

Options.

Reference/Background

This control is used when manually taking and enabling/disabling Background and Reference com-

pensation.



Take Background

This button allows the background portion of the baseline measurement to be taken without having

to re-take the reference measurement.

Take Reference

This button allows the reference portion of the baseline measurement to be taken without having to

re-take the background measurement.

Subtract Background

This feature allows the background subtraction portion of the baseline correction to be disabled.

Use Reference

This feature allows the reference portion of the baseline correction to be disabled.

Optics Configuration



The Optics Configuration dialog box is accessible through both the Setup menu and the Acqui-

sition Settings tab under the Edit Recipe window. It is important to make sure that you remember

to select the proper configuration for your measurements in order to obtain the best possible results.

Not all options are available with all systems.

Display

Spectrum Color Display: Color Space

The color of a spectrum can be displayed and quantified on the main screen if a color space coor-

dinate system is selected.

When a Color Space is selected, the color of the spectrum and the coordinates appear on the main FILMeasure

window.

Spectrum Color Display: Observer

When a specific color space is chosen for display, this option allows the user to choose between

the CIE 1931 2 degree observer and the CIE 1964 10 degree observer. Note that this variable is

associated with the CIE eye-response convention (see, for example, http://e-

n.wikipedia.org/wiki/CIE_1931_color_space) and is unrelated to the illumination or collection

angle of the measurement.

http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/CIE_1931_color_space


Spectrum Color Display: Fixed Luminance

The user can fix the luminance of the displayed color. Since antireflective coatings, for example,

are inherently transmitting, the spectra has very little luminance and the coating color may appear

black on screen. Fixing the luminance does not affect the color space coordinate results.

Spectrum colors of the same spectrum with fixed luminance of 0%, 30%, and 60%, respectively.

Note that fixing the luminance to view the color does not affect the color space coordinate values.

Configuring Number of Spectra

This sets the maximum number of spectra displayed simultaneously on the main FILMeasure

screen. If the maximum number of spectra is reduced to fewer than the number already on the

screen, the most recently selected spectra will remain.

Graph Color Background

The background of the graph color can be set to white or black using this option.

Significant Figures

For systems with the thickness upgrade, the user can select the number of significant figures that

the results display.

Access Control

The software for the instrument incorporates password protection to limit access to the meas-

urement software and settings. When the software is initially installed the access control is turned

off. The software will automatically boot up with Engineer level access that enables access to all

features of the program except turning on and off access control and adding and deleting users.



Turning on access control requires Supervisor level access. The software is delivered with one

user, a supervisor, in the list of authorized users as shown below:

UserID: filmsuper

Password: filmetricsfff

To turn on access control, log in as filmsuper using the password shown above. The Activate

Access Control checkbox should now be enabled. By placing a check mark in the Activate

Access Control checkbox access control will be active. User ID and Password are case-sensitive.

To add an operator level user, select operator from the Access Level list box, type a user name and

type an initial password for that user. Then click the Add User button. To add an engineer or a

supervisor user follow the same procedure, but pick the appropriate access level from the list box

before pressing the Add User button.

To Delete a user, enter the UserID and press the Delete User button.

Operator and Engineer level users can change their passwords when they are logged in by entering

their password into the password box and pressing the change button. Supervisor-level users can

change their password or the password of any other user by selecting the appropriate access level,

entering the appropriate UserID and the new password and pressing Add User. If the program

finds that a user already exists, it will delete the old entry for that user and create a new entry.

We recommend that you create a new supervisor level user and delete the filmsuper user for max-

imum security. If all supervisor level users forget their passwords, it will be necessary to re-install

the software and add all the users again.



Raw Signal

Raw Signal

The Raw Signal dialog box allows the user to plot the raw (no baseline corrections applied) spec-

trometer signal on the main graph. No spectral smoothing is applied, and there are no saturation

warnings. This is useful when adjusting the focus or when setting integration times manually.

Integration Time

This sets the integration time of the spectrometer. Clicking Update Recipe transfers the listed inte-

gration time to the current recipe.

Start/Stop

This starts the display of the spectrometer signal.



Graph Limits

This allows the user to set temporary graph limits.

Options

The General Settings tab is used to enable, disable, and modify various options in the software.

The Selected Camera pull down menu allows the user to enable the Sample Cam, or choose

between different cameras if there is more than one attached to the system. The Reference Signal

Thresholds options are used by the software during the Baseline process. If, during the Acquire

Reference step of the Baseline, the reflectivity of the reference standard goes above or below the

percentages listed an error message will appear.



The Data Recording tab allows for automatic saving of all spectra and results to a central file.

Acquire Menu

Acquire > Continuous Acquire (Measure Tab only)

This feature collects real-time data from the spectrometer. It is useful when searching for a specific

location to measure (for example, locating a more uniform area of the sample that exhibits inter-

ference fringes).

Acquire > Single Acquisition (Measure Tab only)

This function collects a single spectrum without performing any analysis.

Acquire > Continuous Measure (Measure Tab only)

This feature collects real-time spectrum data and analyzes it – similar to repeatedly pressing the

Measure button.

Acquire > Single Measure (Measure Tab only)



This feature collects a spectrum and analyzes it. This is the same as pressing theMeasure Button.

Batch Acquire
The Batch functions allow you to act on groups of spectra, rather than each individual spectrum

Acquire > Batch > Acquire

This option allows you to acquire a pre-selected number of spectra. You can also choose to save

the batched spectra as they are acquired.

Acquire > Batch > Measure

This option allows you to acquire and analyze a pre-selected number of spectra. You can also

choose to save the batched spectra as they are acquired.

Acquire > Batch > Analyze Spectra

This option will apply the currently selected recipe to all open spectra.

Acquire > Batch > Analyze All Spectra in Folder

This option will apply the currently selected recipe to all spectra in a folder. If there are more spec-

tra to be analyzed then the software is set to Display, the analyzed spectra can easily be retrieved

from the History tab.



Help Menu

Diagnostics

The diagnostics window gives information regarding the data taken during baseline routine. Ref-

erence and background counts are shown (this useful to see how much signal the system is getting;

good signals typically are between 2500-3500 counts). Data for the transmittance baseline can be

viewed by changing theMeasurement Sub-module.

Help>Diagnostics shows the user information regarding the data taken during the baseline routine.

Help > About FILMeasure

Information about the hardware and software versions and the system serial number can be found

here. Please have this information available when calling Filmetrics for technical assistance.



Help>About FILMeasure... window

Taking a Baseline
The baseline measurement allows the FILMeasure software to take into account the response inher-

ent to the reflectance measurement hardware. It does this by first measuring the sample, then a ref-

erence standard, and finally by taking a “dark” reading. The light source should be allowed to

stabilize at least ten minutes before the baseline is taken. When measuring films less than 1000Å

thick, the baseline should be periodically re-taken every 20-30 minutes. For thicker films, a new

baseline can be taken less often.

Baseline measurements may be started two ways:

1. Select the Baseline button, which will guide the user through the baseline procedure, or

2. Select Set Up>Reference/Background... from the menu bar in the for manual access to the

baseline functions.

The first step of the baseline measurement is to acquire a spectra of the sample. This is done by



placing the sample on the stage underneath the light path. This step is used by the software to help

determine the needed integration times and cycles to best measure the sample.

The next step is to take a reference spectrum. This done by placing a reference sample of similar

reflectance to the test sample (usually silicon) on the sample stage. The reference material that is

used should be selected from the Reference Material: list. For reference materials not in the list,

reflectance versus wavelength values may be entered into a comma-delimited text file with the

extension “.rrr” (stored in the Material subfolder). When using the SS-3 Stage it is also important

that the sample and reference are roughly the same height, to insure that the light is properly

focused on both.

The method the background measurement is taken will be dependent on the optical set-up. If using

the SS-3 in reflection mode, simply remove the reflectance standard from the stage and click

Acquire Background. The SS-3 has a small angled piece of glass built into the stage to reflect

away the light. If using the SS-3 in transmission mode, the collection optic must be covered using

an opaque object. If using a contact probe, the probe needs to be pointed away from any light

source or reflective surface.

After acquiring a baseline, the instrument is ready to begin making measurements. To verify that

the system is working properly, you may select Acquire>Single Acquire from theMeasure Tab

menu bar, with the reference sample in place. You should see the reflectance spectrum of the ref-

erence material.

Autobaseline

When the Optics Configuration is set to the contact probe, the Autobaseline option can be

selected. This option will automatically perform baseline periodically, so that the user does not

have to do this routinely. Once selected, the Baseline measurement routine mentioned above will

only require the user to measure the BK7 reference and a take a dark reading. A user will only

have to do a manual baseline once per week.



Making Measurements
Accurate measurements with the F20 rely on using the proper measurement setup. The basic steps

for any F20 measurement are:

1) selecting and editing the type of film to be measured

2) taking a baseline measurement

3) clicking on theMeasure button to make the measurement.

Each example below will take you through this sequence of steps. In each example it is assumed

that the hardware has been set up as described in the Quick Start Guide, and that you have first

read through the Software Overview section to familiarize yourself with the basic controls.

TheMeasurement Assumptions, Hints for Improved Accuracy, and Troubleshooting sections

describe techniques that should be followed for the most accurate measurements.

Focusing the Fiber
When the fiber-optic is fully inserted into the lens tube, the SS-3 is designed to provide optimal

focus for subjects the same height as the silicon reference wafer. If the object to be measured is a

different height than the Si wafer please follow the procedure below to focus the fiber-optic.

Instructions for focusing for maximum signal are as follows:

A. Turn on the light source and start the FILMeasure program.

B. Go to the Set Up>Raw Signal… dialog box and set the integration time for 30 mil-

liseconds.

C. Click Start on the Set Up>Raw Signal… dialog box.

D. Place a reflective sample, such as a silicon reference wafer or BK7 reference on the sample

stage. You will now see the raw signal from the image sensor. If the signal saturates, reduce

the integration time (step b).

* * Note * * Focus position is dependent on subject height. Make sure the surface you

intend to measure is at the same height as the reflective sample.

E. Optimize the focus to maximize the measured signal by adjusting the fiber-optic cable posi-

tion in the lens tube. To achieve this, move the fiber-optic cable slightly up the lens tube until

maximum signal is obtained.

The screw on lens tube is actually a spring-loaded ball plunger and does not require tight-

ening. Users should be aware that the fiber may slip out of focus if the stage or cable is



moved. If one focus height is often used, the set screw can be tightened to reduce the chance

of inadvertent slipping.

F. Close the Set Up>Raw Signal… dialog box. Focusing is now complete.

* * Note * * When performing the baseline procedure, always make sure the top sur-

face of the reference material is at the same height as the sample surface you intend to

measure.

There is also a video demonstration of this procedure on YouTube, which can be found here. An

active internet connection will be needed to view the video.

Measuring Thickness
Examples that describe the most common measurement setups are described in this section.

Example 1: Thickness of Films Greater Than ½ Micron Thick

Example 2: Thickness of Films Less Than ½ Micron Thick on Thick Transparent Sub-

strates

Example 3: Thickness of Films Less Than ½ Micron on Thin Transparent Substrates

Example 4: Transmittance Measurements

Example #1: Thickness of Films Greater Than ½ Micron Thick: SiO2 on
Silicon
For this example we will demonstrate only the measurement of SiO2 on silicon (the SiO2 on Sil-

icon Test Sample provided with the F20 may be used), but this type of measurement has an

extremely broad range of applications, including hardcoats, polysilicon, and LCD cell gaps, to

name just a few.

Hardware:

If the sample to be measured is flat, any standard or rotating sample stage will work fine. If the sam-

ple is curved, or is transparent with films on its backside (such as ophthalmic lens applications), a

hand-held contact probe measurement device (e.g., Part# CP-1) may be necessary.

Step 1: Select the film recipe

Select the film structure to be measured, in this case “SiO2 on Si”, from the Recipe: list box on the

main screen. If the structure to be measured does not exist, a new structure must be defined. See

Editing Film Recipe for more details.

http://www.youtube.com/watch?v=RebzoBfonEk


Step 2: Edit the film recipe

To edit the structure, click the Edit Recipe button to open the dialog box. Check to see that the

film sequence matches that of the actual sample. If not, different films can be selected. Also enter

your best guess for the thickness of the film to be measured, and check that only the SiO2 layer

thickness is being measured.

Example Edit Recipe>Film Stack window for measuring the thickness of a thin film greater than ½ micron

thick.

Step 3: Take a Baseline Measurement

Take a baseline measurement by first clicking on the Baseline button on the main screen. A dialog

box will appear to guide you through the process. The first step will consist of a measurement of

your sample. The second step will be a measurement of the reference material. Please make sure

the reference material selected on this dialog box matches the reference you are measuring. For this

sample, you should be using the “Si” reference. Last, you will make a background measurement

by removing the reference from the sample stage.



In the event you are using a contact probe, make the background measurement by pointing the tip

of the probe away from any light source or bright objects. Do not place the contact probe on a dark

surface for the background measurement.

Click “Finish” to complete the baseline procedure.

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage (or the contact probe on your sample)

and click on theMeasure button. FILMeasure will then acquire the reflectance spectrum and cal-

culate the corresponding thickness. If the measurement was successful, the minima and the maxima

of the calculated reflectance (the red line on the graph) will coincide in wavelength with the

minima and the maxima of the measured reflectance (the blue line on the graph). In most cases they

will not overlap, but will be separated in amplitude.

Measured and calculated reflectance spectra when measuring the thickness of SiO2 on silicon.

If the calculated (red) and measured (blue) minima and maxima do not coincide, then the meas-

urement was not successful. There are several possible causes of an unsuccessful measurement.

The most common for this type of measurement are described in Cases #1, #2, #3, and #4 in the

Troubleshooting section.



Example #2: Thickness of Films Less Than ½ Micron Thick on Thick
Transparent Substrates: TiO2 on Glass
This example demonstrates the measurement of TiO2 on glass. This type of measurement has a

broad range of other applications, most commonly optical coating and flat-panel display process

films.

Hardware:

If the sample to be measured is flat, the contact sample stage should be used. If the sample is

curved, the hand-held contact probe (e.g., Part# CP-1) may be necessary.

Step 1: Select the film recipe

Select the film structure to be measured, in this case “TiO2 on Glass”, from the Recipe: list box on

the main screen. If the structure to be measured does not exist, a new structure must be defined see

Editing Film Recipes for more details.



Example Edit recipe>Film Stack window for measuring the thickness of a film less than ½ micron thick on a

thick, clear substrate.

Step 2: Edit the film recipe

To edit the structure, click the Edit Recipe button to open the dialog box. Check to see that the film

sequence matches that of the actual sample. If not, different films can be selected. Also enter your

best guess for the thickness of the film to be measured, and check that only the TiO2 layer thick-

ness is being measured.

Step 3: Take a Baseline Measurement

Take a baseline measurement by first clicking on the Baseline button on the main screen. A dialog

box will appear to guide you through the process. The first step will consist of a measurement of

your sample. The second step will be a measurement of the reference material. Please make sure

the reference material selected on this dialog box matches the reference you are measuring. For this

sample, you should be using the “BK7” reference. Last, you will make a background measurement

by removing the reference from the sample stage.

In the event you are using a contact probe, make the background measurement by pointing the tip

of the probe away from any light source or bright objects. Do not place the contact probe on a dark

surface for the background measurement.

Click “Finish” to complete the baseline procedure.

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage (or the contact probe on your sample)

and click on the Measure button. FILMeasure will then acquire the reflectance spectrum and cal-

culate the corresponding thickness. If the measurement was successful, the minima and the maxima

of the calculated reflectance (the red line on the graph) will coincide in wavelength with the

minima and the maxima of the measured reflectance (the blue line on the graph). In most cases they

will not overlap, but will be separated in amplitude.

Measured and calculated reflectance spectra when measuring the thickness of TiO2 on glass.

If the calculated (red) and measured (blue) minima and maxima do not coincide, then the meas-

urement was not successful. There are several possible causes of an unsuccessful measurement.

The most common for this type of measurement are described in Cases #1, #2, #3, and #4 in the

Troubleshooting section.

Example 3: Thickness of Films Less Than ½ Micron on Thin Transparent
Substrates: MgF2 on Glass Slide
In this example we will demonstrate the measurement of MgF2 on a glass slide.



Hardware:

For this type of measurement the sample must be flat, with the front and backsides parallel. The

standard SS-3 sample stage is required. The contact stage option is recommended. If you are able

to take the baseline measurements with an uncoated substrate, then follow the film structure setup

instructions in Example #2.

Step 1: Select the film recipe

Select the film structure to be measured, in this case “MgF2 on Glass”, from the Recipe: list box on

the main screen. If the structure to be measured does not exist, a new structure must be defined.

See Editing Film Recipes for more information.

Step 2: Edit the film recipe

Example Edit Recipe>Film Stack window for measuring the thickness of films less than ½ micron thick on a

thin transparent substrate.

To edit the structure, click the Edit Recipe button to open the dialog box. Check to see that the

film sequence matches that of the actual sample. If not, different films can be selected. Also enter

your best guess for the thickness of the film to be measured, and check that only the MgF2 layer



thickness is being measured. The Robust (adaptive; thickness only) button should be deselected

under the Analysis Options tab.

Example Edit Recipe>Analysis Options window for measuring the thickness of films less than ½ micron thick

on thin transparent substrate.

Step 3: Take a Baseline Measurement

Take a baseline measurement by first clicking on the Baseline button on the main screen. A dialog

box will appear to guide you through the process. The first step will consist of a measurement of

your sample. The second step will be a measurement of the reference material. Please make sure

the reference material selected on this dialog box matches the reference you are measuring. For this

sample, you should be using the “Si” reference. Last, you will make a background measurement

by removing the reference from the sample stage.

In the event you are using a contact probe, make the background measurement by pointing the tip

of the probe away from any light source or bright objects. Do not place the contact probe on a dark

surface for the background measurement.

Click “Finish” to complete the baseline procedure.



Step 4: Make the Measurement

Make the measurement by placing your sample on the stage (or the contact probe on your sample)

and click on the Measure button. FILMeasure will then acquire the reflectance spectrum and cal-

culate the corresponding thickness. If the measurement was successful, the minima and the maxima

of the calculated reflectance (the red line on the graph) will coincide in wavelength with the

minima and the maxima of the measured reflectance (the blue line on the graph). In most cases they

will not overlap, but will be separated in amplitude.

Measured and calculated reflectance spectra when measuring the thickness of MgF2 on a glass slide.

If the calculated (red) and measured (blue) minima and maxima do not coincide, then the meas-

urement was not successful. There are several possible causes of an unsuccessful measurement.

The most common for this type of measurement are described in Cases #1, #2, #3, and #4 in the

Troubleshooting section.

Example 4: Transmittance Measurements
In this example we will demonstrate the acquisition of a transmittance spectrum.

Hardware:

For this type of measurement the sample must be flat, with the front and backsides parallel. The

standard sample stage equipped with the T-1, Transmission Option, is required. When measuring

very thin films, use of a vacuum plugged into the vacuum port is recommended.



Step 1: Specify Transmittance Configuration

Under the Setup menu select Optics Configuration and select standard stage with transmittance

option.

Setup menu.

Optics Configuration dialog box.



Step 2: Take a Baseline Measurement

Take a baseline measurement by first clicking on the Baseline button on the main screen. A dialog

box will appear to guide you through the process. The first step will be a measurement of the ref-

erence material. Air will be used as our reference material. Select “Enter constant…” from the drop

down list, enter a refractive index of “1” and remove all objects from the light path. The second

step is a background measurement. Place an opaque object over the bottom fiber on the state. No

light should enter the fiber during the measurement.

Click “Finish” to complete the baseline procedure.

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage. Under the Acquire>Single Acquire

from the menu bar.

Single Acquire collects the measured spectrum (blue curve) off of the sample.

Measuring Thickness and Refractive Index
Examples that describe the most common setups for index and thickness measurement are

described in this section.

Example 1: Thickness and Optical Constants of Films on Opaque Substrates



Example 2: Thickness and Optical Constants of Films on Thick Transparent Substrates

Example 1: Thickness and Optical Constants of Films on Opaque Sub-
strates: Si3N4 on Silicon
For this example we will demonstrate the measurement of Si3N4 on silicon but this type of meas-

urement has an extremely broad range of applications, including the measurement of oxides, poly-

silicon, and optical coatings.

Hardware:

Any standard or rotating sample stage should work fine. The sample frontside must be flat. If the

sample backside is not flat and parallel with the frontside, then the contact stage must be used.

Step 1: Select the film recipe

Select the film structure to be measured, in this case “Si3N4 on Si”, from the Recipe: list box on

the main screen. If the structure to be measured does not exist, a new structure must be defined.

See Editing Film Recipes for more details.

Example Edit Recipe>Film Stack window for measuring the thickness, n, and k of films on an opaque sub-

strate.



Step 2: Edit the film recipe

To edit the recipe, click the Edit Recipe button to open the dialog box. Check to see that the film

sequence matches that of the actual sample. If not, different films can be selected. Also enter your

best guess for the thickness of the film to be measured. Also check that thickness, n, and k of the

Si3N4 layer are selected to be measured.

Example Edit Recipe>Analysis Options window for measuring the thickness, n, and k of films on an opaque

substrate.

Step 3: Take a Baseline Measurement

Take a baseline measurement by first clicking on the Baseline button on the main screen. A dialog

box will appear to guide you through the process. The first step will consist of a measurement of

your sample. The second step will be a measurement of the reference material. Please make sure

the reference material selected on this dialog box matches the reference you are measuring. For this

sample, you should be using the “Si” reference. Last, you will make a background measurement

by removing the reference from the sample stage.

In the event you are using a contact probe, make the background measurement by pointing the tip

of the probe away from any light source or bright objects. Do not place the contact probe on a dark

surface for the background measurement.

Click “Finish” to complete the baseline procedure.



Step 4: Make the Measurement

Make the measurement by placing your sample on the stage and click on the Measure button.

FILMeasure will then acquire the reflectance spectrum and calculate the corresponding thickness.

If the measurement was successful, the calculated reflectance (the red line on the graph) will coin-

cide with the measured reflectance (the blue line on the graph).

If the measured and calculated spectra do not fall on top of each other, the resulting thickness, n,

and k values are incorrect. If the mismatch between measured data and calculation is only slight,

the results reported will only be off by a small amount. If the measured and calculated spectra

match, but the results are implausible there may be a problem with the sample positioning and light

collection. Causes and corrective actions to improve the measurements are listed in Cases #5 and

#6 in the Troubleshooting section.

Measured and calculated reflectance spectra when measuring the thickness, n, and k of Si3N4 on silicon

Example 2: Thickness and Optical Constants of Films on Thick Trans-
parent Substrates: MgF2 on BK7
This type of measurement is typically applied to optical coatings on glass substrates, as well as anti-

reflection coatings on various transparent substrates.



Hardware:

The contact stage must be used when measuring the thickness and optical constants of films on a

thick transparent substrate (see Chapter 1 for setup of the contact stage). Use of the contact stage

means that the front side of the sample must be flat.

Step 1: Select the film recipe

Select the film structure to be measured, in this case “MgF2 on BK7”, from the Recipe: list box on

the main screen. If the structure to be measured does not exist, a new structure must be . See Edit-

ing Film Recipes for more details.

Example Edit Recipe>Film Stack window for measuring the thickness, n, and k of films on a thick transparent

substrate.

Step 2: Edit the film recipe

To edit the recipe, click on the Edit Recipe button to open the dialog box. Check to see that the

film sequence matches that of the actual sample. If not, different films can be selected. Also enter

your best guess for the thickness of the film to be measured.



Example Edit Structure>Analysis Options window for measuring the thickness, n, and k of films on a thick

transparent substrate.

Step 3: Take a Baseline Measurement

Take a baseline measurement by first clicking on the Baseline button on the main screen. A dialog

box will appear to guide you through the process. The first step will consist of a measurement of

your sample. The second step will be a measurement of the reference material. Please make sure

the reference material selected on this dialog box matches the reference you are measuring. For this

sample, you should be using the “BK7” reference. Last, you will make a background measurement

by removing the reference from the sample stage.

In the event you are using a contact probe, make the background measurement by pointing the tip

of the probe away from any light source or bright objects. Do not place the contact probe on a dark

surface for the background measurement.

Click “Finish” to complete the baseline procedure.

Step 4: Make the Measurement

Make the measurement by placing your sample on the stage and click on theMeasure button.

FILMeasure will then acquire the reflectance spectrum and calculate the corresponding thickness.

If the measurement was successful, the minima and the maxima of the calculated reflectance (the



red line on the graph) will coincide in wavelength with the minima and the maxima of the meas-

ured reflectance (the blue line on the graph).

If the measured and calculated spectra do not fall on top of each other, the resulting thickness, n,

and k values are incorrect. If the mismatch between measured data and calculation is only slight,

the results reported will only be off by a small amount. If the measured and calculated spectra

match, but the results are implausible there may be a problem with the sample positioning and light

collection. Causes and corrective actions to improve the measurements are listed in Cases #5 and

#6 in the Troubleshooting section.

Measured and calculated reflectance spectra when measuring the thickness, n, and k of MgF2 on BK7 glass.

Measurement Assumptions
The following assumptions must be valid if accurate measurements are to be made with the F20:

1. Every film present in the structure is specified in the Edit Recipe dialog box. This includes

every film present in the sample including so-called adhesion films, oxide films (unless they are

less than 20 Å or greater than 500 microns thick), and films on the bottom surface of the substrate

if the substrate is transparent.

2. The thickness of the measured film is uniform over the spot being measured.



3. The light source has been allowed to warm up for at least 5 minutes if measuring thickness of

films greater than 250nm, or 15 minutes if measuring thickness of films less than 250nm, refractive

index, or reflectance.

In addition, the following assumptions are made if optical constants and/or very thin films (<500

Å) are to be measured:

4. Each film in the structure is homogeneous and uniform (i.e. the refractive index and extinction

coefficient are constant as a function of depth and constant over the entire spot being measured).

5. No significant scattering of the light incident on the sample is occurring, unless it is caused be

slight surface roughness that is being accounted for in the Recipe definition.

6. The top surface of the sample under test is at the same height as the reference sample that was

used to make the reference calibration measurement.

7. The sample is flat. (the vacuum chuck may help in this case when samples are warped.)

8. No changes to the measurement system (such as fibers moved) or light source have occurred

since the acquisition of the most recent baseline.

9. No significant changes in room temperature (> 5 degrees F) have occurred since acquisition of

the most recent baseline.

If any of the above assumptions are not true, it may still be possible to make a measurement, but

accuracy may be degraded.

Hints for Improved Accuracy

This section contains various tips to help improve accuracy in your measurements.

Roughness.

Restricting the wavelength range of the analyzed reflection spectra.

Measuring thickness when the approximate thickness is not well known.

Measuring photosensitive films.

Roughness
Slight amounts of surface or interface roughness may be present that will decrease the GOF value

of a measurement. Entering a value for or solving for roughness can partially account for this rough-

ness so that a betterGOF may be achieved. Generally, roughness is only present when the sample



surface looks hazy at the measurement spot. The fact that haze can be seen means that there is scat-

tered light. (A perfectly smooth surface will scatter no light, and thus the measured spot will not be

visible.) Usually roughness less than 2.5 nm will not be visible, while roughness greater than about

25 nm will be extremely hazy.

FILMeasure assumes a Gaussian distribution of the surface height irregularities about the mean and

it assumes that the roughness is small compared to the wavelength. FILMeasure reports the rms

roughness value.

Restricting the wavelength range of the analyzed reflectance spectrum
Occasionally the spectrum from measured films is adversely affected by factors such as absorbing

dyes, birefringence, or non-uniformity – all of which are difficult to model properly. It is often still

possible to make accurate thickness measurements of these films by analyzing only unaffected por-

tions of the spectra. The portion of the spectrum that is used to calculate film properties is deter-

mined by the graphic display or by Edit Recipe>Analysis Options. An example of the difference

is shown below.

Another faster method of controlling wavelength analysis range is with the gray bar at the bottom

of the graph. Drag either end of the bar to a new position on the x-axis to change the analyzed

range without altering the graph dimensions or editing the recipe.

Example of a non-ideal film (spectrum with no oscillations at lower wavelengths) that requires reduced wave-

length range for accurate measurement.



Example of a reduced wavelength range for measuring thickness of non-ideal films.

Measuring thickness when the approximate thickness is not well known
Unless otherwise specified, FILMeasure will determine a film’s thickness by finding the best

answer within about 1000 Å of the initial (user supplied) value. If the approximate thickness of the

film is not known to better than about 1000 Å, then the Grid method or the Fourier Transform

method of determining approximate thickness may be applied. See Editing Film Structures for

more details.

Measuring photosensitive films
For layers such as unexposed photoresist that cannot be exposed to short-wavelength light, a filter

may be inserted in the slot on the light source

Troubleshooting
Incorrect or unreasonable measurement results can be caused by a number of different factors.

Below are listed some of the more common symptoms of and solutions for poor measurement

results. In all cases it has been assumed that the user has read theMeasurement Assumptions sec-

tion, and that each criteria has been met.



Case #1: No oscillations, or portions of oscillations, are present in the measured reflectance

spectrum.

Case #2: The measured reflectance spectrum has periodic oscillations across the entire

screen, but its minima and maxima do not match up with the calculated reflectance.

Case #3: Two or more different, but nearly the same, thickness readings are obtainable from

the same measurement location.

Case #4: Not all of the measured spectrum displays oscillations

Case #5: Poor matches between the measured and calculated reflectance spectra when meas-

uring thickness and optical constants.

Case #6: Several different answers, or one unreasonable answer, are found when measuring

thickness and optical constants, even though a good match is found between the measured

and calculated reflectance spectra.

Case 1: No oscillations, or portions of oscillations, are present in the
measured reflectance spectrum.
There can be several causes of this. The simplest is that the film may just be very thin (<200 Å).

Also, if the film is very rough, non-uniform in thickness over the measurement area, or has a

graded interface, it may not support coherent optical interference, and thus it may not be able to be

measured. Another cause of no oscillations can be an improper baseline measurement, so usually

the first step when no oscillations are seen is to carefully retake the baseline.

Case 2: The measured reflectance spectrum has periodic oscillations
across the entire screen, but its minima and maxima do not match up
with the calculated reflectance.
The most common cause is that the initial thickness guess was considerably different than the

actual film thickness, and due to the constraints on possible thicknesses, FILMeasure was not able

to look for an answer in the region of the actual thickness. To understand this, it helps to know that

the number of oscillations on the screen is proportional to the film thickness. For example, if the

measured spectrum has roughly twice the number of the oscillations that the calculated spectrum

has, then the measured film is roughly twice the thickness of the calculated thickness. Using this

information, the initial thickness guess and the thickness constraints can be set more appropriately

in the Edit Recipe dialog box. Another possible cause is found in Case #3 (incorrect dispersion).

Case 3: Two or more different, but nearly the same, thickness readings
are obtainable from the same measurement location.
When this occurs usually the measured and calculated spectra match somewhat, but not very well

across the entire spectra (i.e., the measured and calculated spectra match only over a small



wavelength range and then gradually walk off one another outside this wavelength range). When

thickness is the only value being measured, this is normally caused by the refractive index of the

measured layer not matching that used by FILMeasure, especially when the film is greater than one

micron thick. Unless more accurate index values can be obtained, the best way to solve this prob-

lem is to restrict the wavelength range used in the analysis.

Case 4: Not all of the measured spectrum displays oscillations
Some regions of the spectrum are strangely curved (thickness greater than 1 micron). This can be a

symptom of non-uniformity in thicker films. In this case simply restrict the wavelength range used

in the analysis.

Case 5: Poor matches between the measured and calculated reflectance
spectra when measuring thickness and optical constants.
There can be many causes of this problem, including those listed in Case #1 and Case #2 above.

Most commonly when a poor fit between the spectra occurs, it is because:

1) the components of the film structure are not all included in the Edit Recipe>Film Stack

dialog box,

2) very inaccurate initial guesses for the film thickness(es) have been listed,

3) the optical constants listed in the Edit Recipe>Film Stack dialog box are far from the

actual optical constants in the material,

4) the film being measured has properties that are not taken into account by FILMeasure.

Examples of these properties are graded interfaces, non-uniform films, and voids.

Case 6: Several different answers, or one unreasonable answer, are
found when measuring thickness and optical constants, even though a
good match is found between the measured and calculated reflectance
spectra.
This normally occurs when a large number of properties are being measured on a very thin film. In

general, the thinner a film is, the less unique information that can be obtained from it. To under-

stand this, see Theory of Operation. To solve the problem, one must usually reduce the number

of properties being measured.



Advanced Features
This section describes several advanced features available within the FILMeasure 6 software. This

includes a description of the Fast Fourier Transform Thickness solver, as well as how to create and

edit n and k files.

Fast Fourier Transform Thickness Only Mode

Creating and Editing n and k Files

Fast Fourier Transform Thickness Only Mode (FFT
mode)
The FFT mode tends to be more robust when measuring very thick films or thick multi-layer

stacks, where the total thickness is greater than 5 microns.

To activate FFT mode, select the select FFT (Thickness Only) button located on the Analysis

Options > Analysis Method tab in the Edit Recipe box.

The Measure Tab shows a split screen with the measured spectrum on the top graph and the FFT spectrum on

the bottom graph.



In FFT TO mode, instead of matching the measured reflectance spectrum with a calculated reflec-

tance spectrum, FILMeasure identifies the peaks in the FFT Spectrum and uses them to compute

the layer thicknesses. The number of possible FFT peaks is n*(n+1)/2 where n is the number of lay-

ers. Thus, for a two layer structure, we expect to see three peaks in the FFT spectrum.

Figure 4.1 shows the screen just after measurement of a two layer stack using FFT TO Mode. The

upper graph shows a blue curve representing the reflectance spectrum of the sample. The lower

graph shows a blue and red FFT spectrum. The blue FFT spectrum is computed from the measured

reflectance. The red FFT spectrum is computed from the theoretical reflectance spectrum of a layer

stack with the measured layer thicknesses. The small side lobes visible on either side of the two tall

peaks are artifacts of the FFT process and can generally be ignored. The only time the side lobes

will cause a problem is if a weak peak from a multi-layer sample is very close to a much stronger

peak. If this case occurs FILMeasure may lock onto one of the side lobes by mistake and it may

not be possible to measure the layer thickness associated with the weak peak. Reducing the Con-

straint and/or increasing the guess for the thickness for the layer with the weak peak may be help-

ful in getting FILMeasure to lock onto the weak peak. If the peak is too weak to reliably measure it

is best to change the layer structure definition so that the layer corresponding to the weak peak is

eliminated.

Along with the measured layer thicknesses, the Results text box displays important information

about the measurement. This important information includes the Goodness Of Fit (GOF) and a

description of which peaks were used to determine the measured layer thicknesses. In Fig. A5

layer 1 thickness is determined based on the position of the peak located at 4.780 microns and layer

2 thickness is determined using the peak corresponding to layers 1+2 (7.011 microns). Notice that

the thickness of layer 2 is not exactly equal to 7.011-4.780 = 2.231 microns. FILMeasure computes

a thickness for layer 2 of 2.113 microns because it precisely accounts for the fact that layer 2 has a

different refractive index than layer 1.

Discussion of GOF:

A perfect match between measured and theoretical FFT spectra will result in a GOF of 1.0. To

ensure accurate results the user may set a minimum acceptable GOF value by entering a number

between 0 and 1 into GOF Error on the Alarms settings in Edit Recipe. A warning message will

be displayed after each measurement where the GOF falls below the user-specified GOF Error. If

the GOF is less than 1.0 there are several possible causes as follows:

a) Nonuniformity – Any variation of layer thickness within the measurement spot will result in

a reduction in the FFT peak heights. In order to permit easy visual interpretation of the FFT

results FILMeasure always scales the amplitude of the red curve so that it matches the blue

curve. However, if the scaling factor is not 1.0, FILMeasure reports a reduced GOF even if

the red curve appears to exactly match the blue curve on the screen.



b) Incorrect Structure Definition – If the refractive index of one or more layers in the structure

is different from what is described in the layer structure, then the FFT peak amplitudes in the

blue curve will not match the peak heights in the red curve. The software will attempt to scale

the red curve, but if there is more than one FFT peak present, the scaling will only result in

one correct peak height. If you wish to view the impact of changing the refractive index of

one or more layers, simply change the refractive index in the Edit Recipe dialog box and click

Analyze (ReAnalyze). If there is only a single layer you will notice that the GOF will change,

but the red curve should not change much. If there are multiple layers in the structure you will

notice that the relative peak heights in the red curve will change when you click Analyze.

c) Graded Interfaces – The amplitude of the peaks in the FFT spectrum depends on both the

size of the change in refractive index at each interface in the layer structure and the sharpness

of the interface. In many common samples you will find that there is some degree of layer

intermixing at the interface, leading to a weaker than expected reflectance at that interface.

The FFT peak(s) associated with the intermixed interface will suffer a reduced amplitude and

in severe cases the peaks may disappear entirely.

Creating and Editing n and k Files
Creating new n and k files

New n and k files can be created by going to Edit>Material Library… Clicking the New button

will allow the user to define a new material file. Once clicked, while the Default Model is

selected, the user can manually enter wavelength versus n or wavelength versus k values.

The user can also select CustomModel. While this is selected, clicking on theModel… button

allows the user to create n and k files using predefined mathematical models.

Once completed, clicking Save As… will save the new file as a custom material for later use.

Creating n and k files from a calculated spectrum

Files for n and k can be created directly from a calculated spectrum, where n and k are measured.

Once a spectrum is analyzed, go to File>Save Measured n and k… This will save your n and k

files as a custom material which can be loaded into the user recipe.

Editing n and k files

Existing material files can be edited by going to Edit>Material Library… There, the user can

load a material file by clicking Open. Values can then be changed manually. Clicking Save will

save the file for later use.



Converting Microsoft Excel files into FILMeasure n and k files

For wavelength versus n or wavelength versus k data saved in Excel (*.xls) format, the data can be

directly saved as material files that can be read by FILMeasure.

For .nnn and .kkk files.

For both n and k files, the data should follow the format shown below, where the wavelength

values, in units of nanometers, are in the first column, and the n or k values are in the second. Note

that the version number (cell B1) refers to version of the file. For this cell, you can use 1. The mate-

rial number (cell B2) refers to what material category the file corresponds to. The material cat-

egories (and their corresponding numbers) are: metal (1), semiconductor (2), insulator (3),

photoresist (4), and other (5). By putting the correct value for the material number, the file will auto-

matically be sorted into the correct category when selecting the material in the Edit Recipe win-

dow.

To save the file created by Microsoft Excel, go to File>Save As… For Save as Type: choose

CSV (Comma delimited) (*.csv). For n files, save the file as “FILENAME.nnn”, and for k files,

save the file as “FILENAME.kkk” (FILENAME represents the name you wish to call the file;

note that quotation marks must be used to enclose the filename in Excel to force the extension to

.nnn or .kkk). The file can then be saved to the desktop, and Imported using the File>I-

mport>Material File option

For .fitnk files.

The data should follow the format of shown below, where the wavelength values, in units of nano-

meters, are in the first column, index of refraction (n) in the second, and extinction coefficient (k) in

the third.

The first few columns of the file should be identical to the figure below the only exception being

cell B3 which should contain a number describing the material category. The material categories



(and their corresponding numbers) are: metal (1), semiconductor (2), insulator (3), photoresist (4),

and other (5).

To save the file created by Microsoft Excel, go to File>Save As… For Save as Type: choose

CSV (Comma delimited) (*.csv). Save the file as “FILENAME.fitnk” (FILENAME represents

the name you wish to call the file; note that quotation marks must be used to enclose the filename

in Excel to force the extension to .fitnk). The file can then be saved to the desktop, and Imported

using the File>Import>Material File option



Theory of Operation
This section describes how the instruments work and includes the theory the measurements are

based on, specifics about the hardware, and more detail about the baseline measurement.

Measurement Theory

Thickness Measurement Details

Hardware Operation

The Baseline Measurement

Measurement Theory
Our instruments measure thin-film characteristics by either reflecting or transmitting light through

the sample, and then analyzing this light over a range of wavelengths. Because of its wave-like

properties, light reflected from the top and bottom interfaces of a thin-film can be in-phase so that

reflections add, or out-of-phase so that reflections subtract. Whether the reflections are in- or out-

of-phase (or somewhere in between) depends on the wavelength of the light, as well as the thick-

ness and properties of the film (e.g., reflections are in-phase when λ = (2*n*d)/i, where λ is the

wavelength, n is the refractive index, d is the film thickness, and i is an integer). The result is char-

acteristic intensity oscillations in the reflectance spectrum (see Figure below). In general, the

thicker the film, the more oscillations there are in a given wavelength range.

Example of reflectance spectrum with oscillations.



The amplitude of the oscillations is determined by the refractive index and extinction coefficient of

the films and substrate. Therefore, by analyzing the period and amplitude of these oscillations, our

instruments can determine thickness of multiple thin-films.

Thickness Measurement Details
Optical thin-film thickness measurements require the successful completion of two tasks: acqui-

sition and then analysis of an accurate reflectance spectrum. To determine film thickness, FILM-

easure calculates a reflectance spectrum that matches as closely as possible the measured spectrum.

FILMeasure begins with an initial guess for what the reflectance spectrum should look like theo-

retically, based on the user’s input of a film structure for the sample. Then FILMeasure varies the

parameters it is solving for until the calculated reflectance spectrum matches the measured data.

Mathematically, this procedure is complicated by the fact that as the thickness of the films in the cal-

culation is varied there can be many near matches. Therefore, an approach that simply homes in on

a solution by finding successively better approximations will not work unless the starting guess for

optical thickness is within approximately 1000 Å if the actual thickness.

FILMeasure avoids homing in on a false solution by searching the entire acceptable thickness

range to determine the thickness that gives the best possible match between the measured and cal-

culated spectra. The thickness range searched is determined by the initial guess for thickness

together with the thickness constraint. Since the time to find a solution is proportional to the range

of thicknesses being searched it is beneficial to provide an initial guess for the thickness of the films

to be measured.

F20 Hardware Operation
The F20 performs two distinct functions: data acquisition and data analysis. Data analysis specifics

are discussed in Software Overview. In this section we describe how the F20 acquires accurate

spectral reflectance data.

Light is supplied by a tungsten-halogen bulb that generates light from approximately 375 nm to

3000 nm. This light is delivered to and collected from the sample through a fiber-optic cable bun-

dle and a lens. The intensity of the reflected light is measured at different wavelengths with a spec-

trometer. The F20 spectrometer uses a diffraction grating to disperse the light and a linear

photodiode array to measure the light at the different wavelengths. After a user-selectable inte-

gration time, the accumulated charge in each photodiode is read by the computer. Because a longer

integration time results in a larger charge, it is the integration time that determines the sensitivity of

the spectrometer. Adjustment of the integration time is used to obtain the proper signal level. Too

short an integration time results in a weak, noisy signal, while too long of an integration time

results in a saturated signal.



The Baseline Measurement
The baseline measurement allows the FILMeasure software to take into account the response inher-

ent to the reflectance measurement hardware. It does this by measuring a reference sample and by

taking a “dark” reading. In any optical system there are many components whose characteristics

vary with wavelength (e.g., the output of the light source and the sensitivity of the spectrometer).

However, when reflectance measurements are made, only variations in reflectance vs. wavelength

due to the sample under test are of interest. Therefore, FILMeasure must perform a calibration to

determine the spectral response of the system. This is done by making a measurement of a "ref-

erence" sample that has known reflectance characteristics. Note that it is not necessary for the ref-

erence sample to be the same as the substrate upon which films to be measured reside. The only

purpose served by the reference sample is to permit calibration of the optical system. For example,

it is possible to use a Si wafer as the reference sample and then measure films on GaAs, InP, glass,

plastic, etc.

After the reference measurement is made a dark reading is taken. A non-zero dark level is due to

current leakage inherent to photodiodes, which causes each photodiode in the array slowly charges

up even when no light enters the spectrometer. Thus, in order to make an accurate measurement of

the light entering the spectrometer, it is necessary to subtract this “dark” current contribution. This

is the purpose of the “dark” reading, which measures the magnitude of the dark current for a given

integration time. When a “dark” measurement is made, a spectrum is measured that represents the

signal generated by the spectrometer when a sample of zero reflectance is measured. To simulate a

sample with zero reflectance during a “dark” measurement, a specularly reflecting sample can be

held at an angle with the light source turned on, or in many cases the light source may simply be

turned off momentarily during the dark measurement.

Due to drift in the light source and temperature of the spectrometer electronics, it is a good idea to

take a baseline periodically.



Appendices
This section contains information on various topics as listed below:

How to Contact Us

Performance Specifications

How to Replace the Light Bulb

Automation and Data

Software License Agreement

How to Contact Us
We welcome suggestions from our users on ways to improve our software and hardware. Please

send us any suggestions you may have for improvements in the help file or new features you

would like to see in the software.

We may be reached by phone at 858-573-9300, by fax at 858-573-9400, or by e-mail at sup-

port@filmetrics.com.

Performance Specifications

Thickness
Range*

Thickness Range
when measuring n

and k
Accuracy1 Precision2 Stability3

F20 15 nm to 100 µm 100 nm and up

The greater of
0.4% or 2 nm

0.1 nm 0.07 nm
F20 UV 1 nm to 40 µm 50 nm and up 0.1 nm 0.07 nm
F20 NIR 100 nm to 250 µm 300 nm and up 0.2 nm 0.12 nm
F20 EXR 15 nm to 250 µm 100 nm and up 0.1 nm 0.07 nm
F20 UVX 1 nm to 250 µm 50 nm and up 0.1 nm 0.07 nm

F20 XT 10 µm to 1 mm N/A The greater of
0.4% or 5 nm

1 nm 1 nm

*Typical values, film stack dependent.

mailto:support@filmetrics.com?subject=Tech Support Request
mailto:support@filmetrics.com?subject=Tech Support Request
mailto:support@filmetrics.com?subject=Tech Support Request


1 Thermally grown SiO2 on Si (except for F20-XT: Si on SiO2 on Si).

2 Standard deviation of 100 thickness readings of 500 nm SiO2 film on silicon substrate. Value is average of

standard deviations measured over twenty successive days. F20-XT values are based on 7 µm Si on SiO2 on Si

sample.

3 Two sigma based on daily average of 100 readings of 500 nm SiO2 film on silicon, measured over twenty suc-

cessive days. F20-XT values are based on 7 µm Si on SiO2 on Si sample.

Specifications subject to change without notice

System Configurations
Many accessories are available for the F20 series systems. Please refer to the following list to find

different applications for the configuration provided with your system. If you would like infor-

mation on purchasing additional accessories not included, please contact Filmetrics.

SS-3 Stage in Standard Spot position: The SS-3 stage is our standard stage for the F20 system.

This is the most versatile stage, which is shipped with each system unless otherwise specified.

SS-3 in UV position: The SS-3 stage in the UV position is optimized for use in UV applications.

SS-3 Stage in Small Spot position: The SS-3 stage in the small spot position is used to achieve a

smaller spot size for measurement. This is also useful for non-uniform or rough samples. The F20-

XT system comes standard with the SS-3 in the Small Spot position.

UV Extended Range (UVX): UVX systems provide the maximum possible range of thickness

measurements by including both UV and NIR detectors and light sources.

Contact Probe (CP-1): The contact probe is useful for measuring coatings on curved surfaces,

such as ophthalmic lenses. This accessory comes standard with the F20-HC, in place of the SS-3.

Contact Probe for Cylindrical Samples (CP-C): This contact probe is used for measuring coat-

ings on cylindrical samples.

Contact Stage Option (CS-1 Option): The contact stage option is used to measure the thickness

of freestanding films and coatings on glass samples where eliminating the backside reflection of the

glass is necessary. Use of the contact stage requires that the sample be flat.

Transmission Option (T1 Option): This option is used to make transmission measurements for

transparent samples.

Reduced Kinematic Mount with lens assembly (LA1-RKM): This assembly is used for inline

applications, or when a longer working distance in required.



Contact Probe (CP-1 and CP-C)
Connect the Contact Probe to the F20 as shown below. The two fiber ends leading from the Con-

tact Probe are identical; they can be attached to either the light source or spectrometer.

Contact Stage (SS-3 with CS-1 option):
Connect the contact stage fiber optic cable to the F20 as shown below. The two fiber ends leading

from the common end of the fiber are identical and can each be attached to either the light source

or spectrometer. Connect the four 3” legs to the bottom of the SS-3 Sample Stage. Remove the

tilted mirror insert in the SS-3 stage using the supplied 1/16” hex socket driver. Screw the fiber

optic cable common end into the black contact adapter, and then fully insert the contact adapter

into the bottom hole in the SS-3 stage, fastening it with the 1/16” hex driver



Reduced Kinematic Mount with Lens Assembly (LA1-RKM)
Step #1: Connect Fiber-Optic Cable to the F20

Connect the fiber-optic cable between the F20 front panel and the LA1-RKM as shown below.

Slide the fiber-optic cable part way into the lens assembly. The spring-loaded setscrew should be

adjusted so that the fiber-optic cable is held in place, yet it may be moved in and out for focus

adjustments.



Step #2: Adjust the lens assembly:

The focus and tilt of the lens assembly need to be adjusted for maximum signal and assumes that

the lens assembly has been mounted on a fixture approximately 6 inches above the sample surface,

and the “read” return fiber from the lens assembly to be adjusted is connected to the spectrometer

input. The idea here is to adjust the tilt and focus for maximum signal. To do this,

A. Turn on the light source with the front panel switch and start the FILMeasure program.

B. Go to the Set Up>Raw Signal… dialog box and set the integration time for 50 mil-

liseconds.

C. Click Start on the Set Up>Raw Signal… dialog box.

D. The fiber-optic cable contains 7 fibers – a single detection fiber surrounded by 6 illu-

mination fibers. Do a rough focus adjustment by placing a diffuse surface (a business card

works well) at the sample position and then focus the light beam on the sample position by

sliding the fiber-optic cable inside the lens tube. (The diffuse reflector will allow you to see the

beam.) When 6 individual spots can be seen, slide the fiber-optic cable farther into the LA1-

RKM until the spots merge into the center of the illuminated area.



E. Place a reflecting sample, such as a silicon wafer, on the sample stage, under the lens

assembly. You should now see a trace on the screen. Turn the tilt adjustment screws to max-

imize the signal. If the signal saturates, reduce the integration time (see step b).

F. Optimize the focus to maximize the measured signal by adjusting the fiber-optic cable posi-

tion in the lens assembly. Focus the light beam on the sample by sliding the fiber-optic cable

inside the lens tube. To see the beam, it may be necessary to place a diffuse surface, such as a

business card, over the sample. Ideally, the best focus adjustment is when the beam is just

under focused. To achieve this, focus the beam on the reflecting sample, and then move the

fiber-optic cable slightly down in the lens tube until maximum signal is obtained. When fin-

ished, tighten the socket head set screw that secures the fiber. Once again, if saturation occurs,

it may be necessary to reduce the integration time.

G. Repeat steps e) and f) to make certain the adjustments are optimal.

H. The set up is now complete. Close the Set Up>Raw Signal… dialog box.

SS-3 in Small Spot Position
If the SS-3 stage is not already in Small Spot position, it can be repositioned by removing the hex-

socket bolt accessed on the backside of the stage arm. Next connect the fiber-optic cable between

the F20 and the stage as shown below. If the fiber does not have a white label indicating “Light

Source”, then the two fiber ends are identical and can each be attached to either the light source or

spectrometer. Focusing will be required before making measurements, please see Focusing your

fiber-optic.

SS-3 in Standard Position
Connect the fiber-optic cable to the F20 as shown below. Fully insert the fiber-optic cable into the

lens tube. Focusing may be required depending on the height of your sample, please see Focusing



your fiber-optic.

The fiber-optic cable contains 7 fibers – a single detection fiber surrounded by 6 illumination

fibers. The measurement spot size is not the illuminated area, but rather the intersection of the illu-

minated area with the projected image of the detection fiber. When focused for maximum signal,

the measurement spot size is roughly half the diameter of the illuminated area.

Transmission Option (SS-3 with T-1 option):
Connect the fiber-optic cable between the F20 and the stage as shown below. The fiber-optic cable

should be fully inserted into the arm on the stage. The screw on the end of the stage arm is actually

a spring-loaded ball plunger and does not require tightening. Connect the four 3” legs to the bottom

of the SS-3 Sample Stage. Remove the tilted mirror insert in the SS-3 stage using a 1/16” hex

socket driver. Screw one end of the single fiber optic cable into the black adapter and fully insert

the adapter into the bottom hole in the SS-3 stage, fastening it with the 1/16” hex driver. Before tak-

ing a baseline measurement, be sure to set the mode of operation to transmittance. See Example #4

for more information on transmittance measurements.



SS-3 Stage in UV Position
If the SS-3 stage is not already in UV position, it can be repositioned by removing the hex-socket

bolt accessed on the backside of the stage arm. Next connect the fiber-optic cable between the F20,

the UV light source and the stage as shown below. If the fiber does not have a white label indi-

cating “Light Source”, then the two fiber ends are identical and can each be attached to either the

light source or spectrometer. Focusing will be required before making measurements, please see

Focusing your fiber-optic.



SS-3 in UVX Configuration
Connect the fiber-optic cable by attaching the blue end labeled “UV Illumination” to the external

UV light source and the red end labeled “nir illumination” to the internal tungsten-halogen light

source. Attach the remaining two ends to the respective color coded spectrometer inputs: blue for

UV, red for NIR. Make sure that only the Deuterium bulb is turned on in the UV light source.

Insert the fiber-optic cable into the lens tube. Focusing the fiber may be required depending on the

height of your sample, please see Focusing your fiber-optic.

Light Bulb Replacement

* * Warning: * * Hazardous voltages are present within the unit. Never attempt any
maintenance without disconnecting the power cord.

Step by step:

1. Exit FILMeasure program and turn off your computer.

2. Disconnect power cable from the back of the unit.

3. Disconnect fiber optic cables from the front of the unit.

4. Remove the two captive screws on the back panel opening the two halves of the enclosure.



* * Warning: * * Caution, avoid touching any interior components, other than the
lamp, lamp base, and housing.

5. Pull the plunger behind the lamp all the way out.

6. Slide the lamp out of it holder, being careful not to touch the glass.

7. Unplug the old bulb from the lamp power connector.

8. Plug new lamp into the lamp power connector. Do not test lamp with lid removed.

9. Slide the new lamp into the holder, being careful not to touch the glass.

10. Gently release the plunger, holding the bulb in it's proper place. Do not test the bulb with the

cover removed.

11. Replace the cover and tighten the screws.

Automation and Data
Measurements can be automated and additional data analysis can be performed by user-supplied

software that communicates with FILMeasure. The mechanism by which this occurs is the FIRe-

mote class which is part of FILMeasure.exe. FIRemote is exposed as a public assembly and is

accessible using the Microsoft .NET programming environment. The best way to learn how to use

the FIRemote class is to look at the example program and source code which are automatically

installed as part of the FILMeasure software. Assuming that the FILMeasure program is installed in

the default location, the example software can be found in C:\Program Files\Fil-

metrics\FILMeasure\SourceCode\FIRemoteTest. Additionally, an executable, FIRemoteTest.exe,

is located in the FILMeasure folder. All of the available commands can be tested using FIRe-

moteTest.exe.

Some of the methods listed in the following reference a SystemGuid. In the terminology used in

this document, a Measurement System is an object comprising one or more measurement channels,

but with operations that can be performed simultaneously on all the channels in the system. The

SystemGuid is used to distinguish between multiple simultaneously connected measurement sys-

tems. Examples of measurement systems with multiple measurement channels include the F32 and

F37. Documentation for methods applying only to such measurement systems can be found in the

Less Commonly Used Methods section. In addition, some methods will accept either a Sys-

temGuid or a ChannelGuid. Such methods thus will execute an operation either on a single chan-

nel, or simultaneously on all channels of a system.



Methods, Property and Events:

ShowFILMeasureGUI

AcquireSpectrum

ActivateChannelDisplayTab

AnalyzeSpectrum

AuthenticateRefBac

BaselineAcquireBackgroundAfterRef

BaselineAcquireReference

BaselineAcquireReferenceT

BaselineAcquireReferenceUsingOldSampleReflectance

BaselineAcquireSpectrumFromSample

BaselineCommit

BaselineSetRefMat

MeasChannelGuid

MeasChannelGuids

MeasChannelHWName

MeasChannelHWSerialNumber

MeasChannelName

Measure

NumberOfChannels

NumberOfSpectrometers

NumberOfSubSystems

OpticsConfiguration

OpenSpectrum

SaveSpectrum

SetRecipe

SetRoughness

SetThickness

Less Commonly Used Methods

The following methods are only rarely used. Methods which refer to a System are used with the

F32 and F37 thin film monitoring systems. Many methods accept either a measSystem or a meas-

Channel guid. However, some methods are relevant only to a single channel. If you supply a meas-

System guid as the argument for one of these methods, an exception will be thrown.

ActivateMonitorDisplayTab

MeasSystemGuid

MeasSystemGuids

MeasSystemHWName

MeasSystemName

NumberOfSystems

SystemAutoSave



SystemAutoSaveBaseFileNameAndPath

SystemMeasure

SystemStartMonitoring

SystemStopMonitoring

SystemMeasurementCompletedEventHandler

showFILMeasureGUI
Methods, Properties, and Events:

Public Sub New(ByVal showFILMeasureGUI As Boolean) (dep-

recated)

Public Sub New(ByVal showFILMeasureGUI As Boolean, ByRef the-

ConstructorWarning As ConstructorWarning, ByRef warningMessage

As String)

showFILMeasureGUI – Determines if the FILMeasure user interface is visible.

theConstructorWarning – Returned value of type ConstructorWarning (None or Star-

tupRecipeLoadFailure).

warningMessage – Returned warning message string. Empty if None.

Remarks: You can suppress the display of the FILMeasure user interface by setting show-

FILMeasureGUI to False. Typically, you would show the user interface during software devel-

opment in order to aid in the testing and debugging process. The constructor with one argument

has been superseded by the constructor with three arguments. This new constructor warns if the

startup recipe has problems loading and a default recipe is loaded instead.

Return to Index...

AcquireSpectrum
Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Sin-

gle, ByRef spectrumData() As Single)

Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Sin-

gle, ByRef spectrumData() As Single, ByVal flushPipeline As

Boolean)

Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Sin-

gle, ByRef spectrumData() As Single, ByRef sec-

ondarySpecWavelengths() As Single, ByRef secondarySpecData()

As Single, ByRef primarySpecIsReflectance As Boolean)



Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Sin-

gle, ByRef spectrumData() As Single, ByVal sec-

ondarySpecWavelengths() As Single, ByRef secondarySpecData()

As Single, ByVal flushPipeline As Boolean, ByRef pri-

marySpecIsReflectance As Boolean)

Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid,

ByRef spectrumWavelengths() As Single, ByRef spectrumData() As

Single)

Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid,

ByRef spectrumWavelengths() As Single, ByRef spectrumData() As

Single, ByVal flushPipeline As Boolean)

Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid,

ByRef primarySpecIsReflectance As BooleanByRef spec-

trumWavelengths() As Single, ByRef spectrumData() As Single)

Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid,

ByRef spectrumWavelengths() As Single, ByRef spectrumData() As

Single, ByVal flushPipeline As Boolean, ByRef pri-

marySpecIsReflectance As Boolean)

measChannelGuid – The GUID of the measurement channel for which a spectrum should be

acquired. If multiple measurement channels exist, the measChannelGuid must be specified.

spectrumWavelengths – Array to contain wavelengths of measured spectum data points.

spectrumData – Measured reflectance or transmittance data points.

secondarySpecWavelengths – For systems that can simultaneously acquire reflectance and trans-

mittance such as the F10-VC, array to contain wavelengths of measured secondary spectum data

points. For all other systems, the returned argument is Nothing.

secondarySpecData – For systems that can simultaneously acquire reflectance and transmittance

such as the F10-VC, array to contain the measured secondary spectum data points. For all other sys-

tems, the returned argument is Nothing.

flushPipeline – If set to True (default), any data currently being acquired is ignored and new data is

acquired. If set to False, data currently being acquired is returned when acquisition is finished.

primarySpecIsReflectance – Indicates whether the primary spectrum data is Reflectance or Trans-

mittance.

Remarks: It is important that you catch exceptions which may occur as a result of calling this

method. See the example program for details.

Return to Index...



ActivateChannelDisplayTab
Public Sub ActivateChannelDisplayTab(ByVal measChannelGuid As

Guid)

measChannelGuid – The GUID of the measurement channel of the corresponding Measurement

Tab to be selected.

Remarks: After execution, the active tab in the FILMeasure GUI will be the specified Meas-

urement Tab. This method should only be executed if multiple measurement channels exist.

Return to Index...

AnalyzeSpectrum
Public Function AnalyzeSpectrum(ByVal formatSummaryAsRtf As

Boolean) As FIMeasResults

Public Function AnalyzeSpectrum(ByVal formatSummaryAsRtf As

Boolean, ByVal addToHistory As Boolean) As FIMeasResults

Public Function AnalyzeSpectrum(ByVal measChannelGuid As Guid,

ByVal formatSummaryAsRtf As Boolean) As FIMeasResults

Public Function AnalyzeSpectrum(ByVal measChannelGuid As Guid,

ByVal formatSummaryAsRtf As Boolean, ByVal addToHistory As

Boolean) As FIMeasResults

measChannelGuid – The GUID of the measurement channel for which a spectrum should be

analyzed and optionally added to history. If multiple measurement channels exist, the meas-

ChannelGuid must be specified.

formatSummaryAsRtf – The measurement summary returned by the .ResultsSummary property of

the FIMeasResults object can be formatted as either plain text or as rtf. Formatting the summary as

rtf is advantageous if it will be displayed to the user because then the full set of information includ-

ing bold font and colors will be included.

addToHistory – Normally, each analysis result is added to the collection of results displayed in the

History area of FILMeasure. In some cases, it may be advantageous to suppress the addition of a

result to the History area. One example where this may be needed is the case where you wish to

analyze a spectrum with two different measurement recipes and then add only the best result to the

History.

Remarks: The most-recently acquired spectrum can be analyzed by calling this function.

Return to Index...



AuthenticateRefBac
Public Sub AuthenticateRefBac()

Public Sub AuthenticateRefBac(ByVal measChannelOrSystemGuid As

Guid)

measChannelOrSystemGuid – The GUID of the measurement channel for which a baseline should

be recovered. If multiple measurement channels exist, the measChannelGuid must be specified.

Remarks: Calling this method is equivalent to clicking Baseline… to display the Baseline dialog

and then clicking Recover Last Baseline… to recover an old baseline spectrum. Note that there are

many situations where an exception may be generated by calling this method. See the example pro-

gram for details.

Return to Index...

BaselineAcquireBackgroundAfterRef
Public Sub BaselineAcquireBackgroundAfterRef()

Public Sub BaselineAcquireBackgroundAfterRef(ByVal meas-

ChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of the measurement channel for which a background

should be acquired. If multiple measurement channels exist, the measChannelGuid must be spec-

ified.

Remarks: This method provides a means to automate what is most commonly called step #3 of the

Baseline procedure (step #4 for F10-VC, “Reflection Only” or “Reflection and Transmittance”.

step #2 for F10VC “Transmittance Only”). As the name of this method implies, you must have pre-

viously acquired a reference spectrum.

Return to Index...

BaselineAcquireReference
Public Sub BaselineAcquireReference()

Public Sub BaselineAcquireReference(ByVal meas-

ChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of the measurement channel for which a reference

should be acquired. If multiple measurement channels exist, the measChannelGuid must be spec-

ified.

Remarks: This method provides a means to automate what is most commonly called step #2 of the

Baseline procedure. Calling BaselineAcquireReference may generate an exception. There are a



number of rules required for successful execution of this method. Unless the acquisition timing

mode in the recipe is set to Manual, you must first call BaselineAcquireSpectrumFromSample. Alter-

natively, you could call the variant of this method which accepts a user-supplied reflectance value

if you know the sample reflectivity and wish to skip step #1.

Return to Index...

BaselineAcquireReferenceT
Public Sub BaselineAcquireReferenceT()

Public Sub BaselineAcquireReferenceT(ByVal meas-

ChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of the measurement channel for which a Transmittance

reference should be acquired. If multiple measurement channels exist, the measChannelGuid must

be specified.

Remarks: This method should only be called for the F10-VC. It provides a means to automate step

#3 of the Baseline procedure for “Reflectance Only” or “Reflectance and Transmittance” modes,

or step #1 of the Baseline procedure for “Transmittance Only” mode. No sample should be posi-

tioned on stage when called.

Return to Index...

BaselineAcquireReferenceUsingOldSampleReflectance
Public Sub BaselineAcquireReferenceUsingOldSampleReflectance()

Public Sub

BaselineAcquireReferenceUsingOldSampleReflectance(ByVal meas-

ChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of the measurement channel for which a reference

should be acquired. If multiple measurement channels exist, the measChannelGuid must be spec-

ified.

Remarks: This method provides a means to automate steps 1 and 2 of the Baseline procedure by

assuming that the sample reflectance is unchanged from what it was the last time a baseline pro-

cedure was performed. Note that an exception may be thrown in some situations including the case

where no prior baseline spectrum exists.

Return to Index...

BaselineAcquireSpectrumFromSample
Public Sub BaselineAcquireSpectrumFromSample()



Public Sub BaselineAcquireSpectrumFromSample(ByVal meas-

ChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of the measurement channel for which a sample spec-

trum should be acquired. If multiple measurement channels exist, the measChannelGuid must be

specified.

Remarks: This method provides a means to automate what is most commonly called step #1 of the

Baseline procedure.

Return to Index...

BaselineCommit
Public Sub BaselineCommit()

Public Sub BaselineCommit(ByVal measChannelOrSystemGuid As

Guid)

measChannelOrSystemGuid – The GUID of the measurement channel for which a new baseline

should be commited. If multiple measurement channels exist, the measChannelGuid must be spec-

ified.

Remarks: Call this method to finalize the baseline procedure and commit the acquired spectra for

use as a new baseline measurement.

Return to Index...

BaselineSetRefMat
Public Sub BaselineSetRefMat(ByVal theRefMat As String)

Public Sub BaselineSetRefMat(ByVal measChannelOrSystemGuid As

Guid, ByVal theRefMat As String)

measChannelOrSystemGuid – The GUID of the measurement channel for which the reference

material should be assigned. If multiple measurement channels exist, the measChannelGuid must

be specified.

theRefMat – The reference material as it would normally appear in the list of reference materials

shown in the Baseline dialog.

Remarks: This method should be called prior to acquiring a reference spectrum

Return to Index...



MeasChannelGuid
Public ReadOnly Property MeasChannelGuid(ByVal meas-

ChannelIndex As Integer) As Guid

Public ReadOnly Property MeasChannelGuid(ByVal measSystemGuid

As Guid, ByVal measChannelIndex As Integer) As Guid

measSystemGuid – The GUID of a measurement system.

measChannelIndex – The zero-based index of the measurement channel.

Remarks: Returns the GUID of the specified channel. Note this can be used to obtain the GUID

used by all methods requiring a measChannelGUID. Also note that the relationship between meas-

ChannelIndex and MeasChannelGuid is not static. Future versions of FILMeasure will dynam-

ically reorder this list in response to an equipment connect/disconnect event. You should not rely

on the order of the channels in the list when attempting to perform a command on a certain chan-

nel.

Return to Index...

MeasChannelGuids
Public ReadOnly Property MeasChannelGuids() As Collection(Of

Guid)

Remarks: Returns a collection of GUID for each measurement channel that exists.

Return to Index...

MeasChannelHWName
Public ReadOnly Property MeasChannelHWName(ByVal meas-

ChannelGuid As Guid) As String

measChannelGuid – The GUID of the measurement channel for which the channel hardware

name should be returned.

Remarks: The hardware name is composed of a system name string and a serial number string sep-

arated by a colon. Example: F20:09A006.

Return to Index...

MeasChannelHWSerialNumber
Public ReadOnly Property MeasChannelHWSerialNumber(ByVal meas-

ChannelGuid As Guid) As String



Public ReadOnly Property MeasChannelHWSerialNumber(ByVal meas-

ChannelGuid As Guid, ByVal spectrometerIndex As Integer) As

String

Public ReadOnly Property MeasChannelHWSerialNumber(ByVal meas-

ChannelGuid As Guid, ByVal subsystemIndex As Integer, ByVal

spectrometerIndex As Integer) As String

measChannelGuid – The GUID of the measurement channel.

spectrometerIndex – The spectrometer index (to specify which of multiple spectrometers in the

channel).

subsystemIndex – The subsystem index (to select among multiple subsystems in the channel).

Remarks: Returns the controller hardware serial number of the specified spectrometer. If the spec-

trometer or subsystem are not specified, the default index = 0 will be used. If there are multiple sub-

systems, a hyphen followed by the subsystem ID is appended to the hardware serial number.

Example for single subsystem: 09A006. Example for multiple subsystem: 09A007-1

Return to Index...

MeasChannelName
Public ReadOnly Property MeasChannelName(ByVal measChannelGuid

As Guid) As String

measChannelGuid – The GUID of the measurement channel for which the channel name should

be returned.

Remarks: By default the channel name is the empty string.

Return to Index...

Measure
Public Function Measure(ByVal formatSummaryAsRtf As Booleanl)

As FIMeasResults

Public Function Measure(ByVal formatSummaryAsRtf As Booleanl,

ByVal addToHistory As Booleanl) As FIMeasResults

Public Function Measure(ByVal measChannelGuid As Guid, ByVal

formatSummaryAsRtf As Booleanl) As FIMeasResults

Public Function Measure(ByVal measChannelGuid As Guid, ByVal

formatSummaryAsRtf As Booleanl, ByVal addToHistory As

Booleanl) As FIMeasResults



measChannelGuid – The GUID of the measurement channel for which a spectrum should be

acquired and analyzed. If multiple measurement channels exist, the measChannelGuid must be

specified.

formatSummaryAsRtf – The measurement summary returned by the .ResultsSummary property of

the FIMeasResults object can be formatted as either plain text or as rtf. Formatting the summary as

rtf is advantageous if it will be displayed to the user because then the full set of information includ-

ing bold font and colors will be included.

addToHistory – Normally, each analysis result is added to the collection of results displayed in the

History area of FILMeasure. In some cases, it may be advantageous to suppress the addition of a

result to the History area. One example where this may be needed is the case where you wish to

analyze a spectrum with two different measurement recipes and then add only the best result to the

History.

Remarks: Calling this function is equivalent to clicking the Measure button in FILMeasure. Note

that if the Measure button is disabled when you call this function, an exception will be thrown.

Return to Index...

NumberOfChannels
Public ReadOnly Property NumberOfChannels() As Integer

Remarks: Number of measurement channels that exist.

Return to Index...

NumberOfSpectrometers
Public ReadOnly Property NumberOfSpectrometers(ByVal meas-

ChannelGuid As Guid) As Integer

Public ReadOnly Property NumberOfSpectrometers(ByVal meas-

ChannelGuid As Guid, ByVal subsystemIndex As Integer) As

Integer

measChannelGuid – The GUID of the measurement channel.

subsystemIndex – Thesubsystem index (to specify which of multiple subsystems in the channel).

Remarks: The number of spectrometers in the specified subsystem. If subsystemIndex is not pro-

vided, the default index = 0 will be used.

Return to Index...



NumberOfSubSystems
Public ReadOnly Property NumberOfSubSystems(ByVal meas-

ChannelGuid As Guid) As Integer

measChannelGuid – The GUID of the measurement channel.

Remarks: The number of subsystems that compose the specified measurement channel.

Return to Index...

OpticsConfiguration
Public Property OpticsConfiguration() As Optic-

sConfigSystemTypes [Get/Set]

Public Property OpticsConfiguration(ByVal measChannelGuid As

Guid) As OpticsConfigSystemTypes [Get/Set]

measChannelGuid – The GUID of the measurement channel for which the OpticsConfiguration is

to be get/set. If multiple measurement channels exist, the measChannelGuid must be specified.

Remarks: If the OpticsConfigSystemTypes is not be compatible with the hardware an exception

will be thrown.

Return to Index...

OpenSpectrum
Public Sub OpenSpectrum(ByVal filenameAndPath As String)

Public Sub OpenSpectrum(ByVal filenameAndPath As String, ByVal

measChannelGuid As Guid)

filenameAndPath – The full path and filename (including extension) of the spectrum. If the file can-

not be opened, an exception will be thrown.

measChannelGuid – The GUID of the measurement channel for a spectrum is to be opened. If mul-

tiple measurement channels exist, the measChannelGuid must be specified.

Remarks: Unlike the behavior when a spectrum is opened in FILMeasure, the software will not

automatically analyze the spectrum after opening it. If analysis of the spectrum is desired, then the

Analyze function must be called.

Return to Index...

SaveSpectrum
Public Sub SaveSpectrum(ByVal filenameAndPath As String)



Public Sub SaveSpectrum(ByVal filenameAndPath As String, ByVal

ifTextFormatWriteYDataAsPercent As Boolean)

filenameAndPath – The full path and filename (including extension) of the spectrum. The file for-

mat is determined by the extension. Valid file extensions are the same as the extensions listed in the

Save Spectrum dialog windows accessed via the File->Save Measured Spectrum menu item in

FILMeasure.

ifTextFormatWriteYDataAsPercent – If this version of SaveSpectrum without this parameter is

called, the result is the same as calling the version with this parameter and setting its value to True.

Thus, the only reason to call the second variant of the function is if the spectrum is being saved as a

text format (either .txt or .csv) and the value of this parameter is set to False

Return to Index.

SetRecipe
Public Sub SetRecipe(ByVal measChannelGuid As Guid, ByVal

recipeName As String)

Public Sub SetRecipe(ByVal recipeName As String)

measChannelGuid – The GUID of the measurement channel. If multiple measurement channels

exist, the measChannelGuid must be specified (since each measurement channel has its own active

recipe).

recipeName – The recipe name to be selected must exist in the list of recipes. Note that you can

select recipes contained in subfolders by specifying the relative path, using the backslash character

‘\’ to separate folder names as is conventional in path naming.

Remarks: The current spectrum will not be automatically reanalyzed when a new recipe is selected.

To reanalyze the spectrum you must call AnalyzeSpectrum.

Return to Index.

SetRoughness
Public Sub SetRoughness(ByVal measChannelGuid As Guid, ByVal

layerNumber As Integer, ByVal roughness_nm As Single)

Public Sub SetRoughness(ByVal layerNumber As Integer, ByVal

roughness_nm As Single)

measChannelGuid – The GUID of the measurement channel. If multiple measurement channels

exist, the measChannelGuid must be specified (since each measurement channel has its own active

recipe).



layerNumber – The layer number for which to modify the roughness.

roughness_nm – Roughness value which will appear in the Layers tab of the recipe for the spec-

ified layer. Units are nanometers.

Remarks: You can alter the roughness of a layer in the current recipe using the method. An excep-

tion will be thrown if the layer number or roughness are out-of-bounds.

Return to Index

SetThickness
Public Sub SetThickness(ByVal measChannelGuid As Guid, ByVal

layerNumber As Integer , ByVal thickness_nm As Single)

Public Sub SetThickness(ByVal layerNumber As Integer, ByVal

thickness_nm As Single)

measChannelGuid – The GUID of the measurement channel. If multiple measurement channels

exist, the measChannelGuid must be specified (since each measurement channel has its own active

recipe).

layerNumber – The layer number for which to modify the thickness.

thickness_nm – Thickness value which will appear in the Layers tab of the recipe for the specified

layer. Units are nanometers.

Remarks: You can alter the thickness of a layer in the current recipe using the method. An excep-

tion will be thrown if the layer number or roughness are out-of-bounds.

Return to Index

ActivateMonitorDisplayTab
Public Sub ActivateMonitorDisplayTab()

Public Sub ActivateMonitorDisplayTab(ByVal measSystemGuid As

Guid)

measSystemGuid – The GUID of the measurement System. If multiple measurement channels

exist, the measChannelGuid must be specified (since each measurement channel has its own active

recipe).

Remarks: This function is provided to permit synchronization of the FILMeasure user interface

with the user interface of a client program.

Return to Index...



MeasSystemGuid
Public ReadOnly Property MeasSystemGuid(ByVal measSystemIndex

As Integer) As Guid

measSystemIndex – The zero-based index of the system.

Remarks: Returns the GUID of the specified system. Note this can be used to obtain the GUID

used by all methods requiring a measSystem GUID. Also note that the relationship between meas-

SystemIndex and MeasSystemGuid is not static. Future versions of FILMeasure will dynamically

reorder this list in response to an equipment connect/disconnect event. You should not rely on the

order of the systems in the list when attempting to perform a command on a certain system.

Return to Index...

MeasSystemGuids
Public ReadOnly Property MeasSystemGuids() As Collection(Of

Guid)

Remarks: Returns a collection of GUIDs containing one item for each measurement system that

exists.

Return to Index...

MeasSystemHWName
Public ReadOnly Property MeasSystemHWName(ByVal systemGuid As

Guid) As String

systemGuid – The GUID of a measurement system.

Remarks: The hardware name is composed of a system name string and a serial number string sep-

arated by a colon. Example: F37:09A006

Return to Index...

MeasSystemName
Public ReadOnly Property MeasSystemName(ByVal systemGuid As

Guid) As String

systemGuid – The GUID of a measurement system.

Remarks: The default system name is the empty string.



Return to Index...

NumberOfSystems
Public ReadOnly Property NumberOfSystems() As Integer

Remarks: Number of measurement systems that exist.

Return to Index...

SystemAutoSave
Public Property SystemAutoSave() As Boolean

Public Property SystemAutoSave(ByVal systemGuid As Guid) As

Boolean

systemGuid – The GUID of a measurement system.

Remarks: You can set or get the state of the AutoSave setting using this property. Note that setting

a new state for SystemAutoSave will not affect an on-going monitor process, but will take effect

the next time a new set of data starts being collected.

Return to Index...

SystemAutoSaveBaseFileNameAndPath
Public Property SystemAutoSaveBaseFileNameAndPath() As String

Public Property SystemAutoSaveBaseFileNameAndPath(ByVal sys-

temGuid As Guid) As String

systemGuid – The GUID of a measurement system.

Remarks: You can set or get the base filename and path for the AutoSave file using this property.

The full filename is generated by appending a date and time stamp to the base filename. Note that

setting a new filename will not affect an on-going monitor process, but will take effect the next

time a new set of data starts being collected.

Return to Index...

SystemMeasure
Public Function SystemMeasure() As FIMeasResultValuesOnly

Public Function SystemMeasure(ByVal dele-

teAccumulatedDataBeforeMeasure As Boolean) As FIMeas-

ResultValuesOnly

Public Function SystemMeasure(ByVal systemGuid As Guid) As

FIMeasResultValuesOnly



Public Function SystemMeasure(ByVal systemGuid As Guid, ByVal

deleteAccumulatedDataBeforeMeasure As Boolean) As FIMeas-

ResultValuesOnly

deleteAccumulatedDataBeforeMeasure – There is no analog for this parameter in the user inter-

face. Setting this parameter to True causes any existing accumulated data points to be deleted

before the measurement is performed.

systemGuid – The GUID of a measurement system.

Remarks: Acquire and measure on all channels in a system. Measurement is performed simul-

taneously on all channels. Measured results are contained in an FIMeasResultValuesOnly object.

Return to Index...

SystemStartMonitoring
Public Sub SystemStartMonitoring()

Public Sub SystemStartMonitoring(ByVal systemGuid As Guid)

systemGuid – The GUID of a measurement system.

Remarks: This function starts a monitoring process

Return to Index...

SystemStopMonitoring
Public Sub SystemStopMonitoring()

Public Sub SystemStopMonitoring(ByVal systemGuid As Guid)

Remarks: This function stops a monitoring process.

Return to Index...

SystemMeasurementCompletedEventHandler
Public Delegate Sub

SystemMeasurementCompletedEventHandler(ByVal systemGuid As

Guid, ByVal theResults As FIMeasResultValuesOnly)

Public Event SystemMeasurementCompleted As Sys-

temMeasurementCompletedEventHandler

systemGuid – The GUID of a measurement system.

Remarks: This event is raised upon completion of a SystemMeasure task and after each meas-

urement during a SystemMonitor process. You should avoid performing lengthy operations (such



as writing data to a file) in the handler for this event because the monitor process will be halted

until the handler function exits. If execution of a lengthy operation is needed, you should invoke a

different thread to perform the operation. If the event is raised as a result of completing a Sys-

temMeasure task, then you will need to exercise care to avoid creating a threading deadlock. A

deadlock will occur if you invoke the thread which called SystemMeasure in the handler for this

event because that thread will not return from SystemMeasure until all the event handlers have fin-

ished executing. See the FIRemoteTest example program to see one way to avoid the deadlock

problem.

Return to Index...

Filmetrics, Inc. Software License Agreement

BY COMMENCING USE OF THIS PRODUCT YOU AGREE TO BECOME BOUND BY

THE TERMS AND CONDITIONS OF THIS AGREEMENT.

LICENSE

This license agreement ("license") permits you to use one copy of FILMeasure ("Software") on

any single computer. The Software is owned by Filmetrics, Inc. and is protected by United States

copyright law and international treaty provisions. Therefore, this software should be treated as any

other copyrighted material except that you may either: (1) make one copy of the Software for

archival backup purposes, or (2) copy the Software to a single hard disk. If the Software is used on

a networked computer system where more than one computer can access the Software provisions

must be made to insure that the number of concurrently executing copies of the Software cannot

exceed the number of licenses.

You may transfer the Software and all rights under this Agreement to another party together with a

copy of this Agreement if the other party agrees to accept the terms and conditions of this Agree-

ment. If you transfer the Software, you must at the same time either transfer all copies (including

any prior versions) in any form to the same party or destroy any copies not transferred.

RESTRICTIONS

You may not use, disclose, copy, modify, rent, lease, loan, resell, network or transfer the Software,

or any copy, modification or merged portion thereof, in whole or in part, except as expressly spec-

ified in this Agreement.

You agree not to decompile, reverse engineer, disassemble or otherwise reduce the Software to a

human perceivable form.

SOURCE CODE

If source code to the Software was supplied to you, then you may modify and use that source code

in place of the executable version of the Software, but no further rights to distribution or use are

granted.

TERM

This Agreement is effective until terminated. You may terminate it at any time by destroying the

Software together with all copies, modifications and merged portions in any form. This Agreement

will immediately and automatically terminate without notice if you fail to comply with any term or



condition of this Agreement. You agree upon termination to promptly destroy the Software

together with all copies in any form.

GOVERNMENT LICENSEE

The Software Product qualifies as "commercial computer software" and the associated doc-

umentation qualifies as "commercial computer software documentation" within the meaning of the

48 C.F.R. 2.101. Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-

4, all U.S. Government end users acquire the Software Product and its documentation with only

those rights set forth in this Agreement.

EXPORT LAW ASSURANCES

You acknowledge and agree that the Software is subject to restrictions and controls imposed by the

United States Export Administration Act (the "Act") and the regulations thereunder. You agree

and certify that neither the Software nor any direct product thereof is being or will be acquired,

shipped, transferred or re-exported, directly or indirectly, into any country prohibited by the Act

and the regulations thereunder or will be used for any purpose prohibited by the same.

GENERAL

This Agreement will be governed by the laws of the State of California. You acknowledge that

you have read this Agreement, understand it and agree to be bound by its terms and conditions.

You further agree that it is the complete and exclusive statement of the agreement between us

which supersedes any proposal or prior agreement, oral or written, and any other communications

between us in relation to the subject matter of this Agreement.

Filmetrics, Inc. Limited Liability Statement

In no event will Filmetrics, Inc. be liable for any damages or expenses, including any lost profits,

lost savings, or other incidental or consequential damages arising or associated with the use of, mis-

use of, or inability to use its products.
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